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Welcome to iSBISTER's Time & Chaos Professional

Our goal is to provide you with an intuitive application for managing your personal
information. Our lives revolve around time and the chaos surrounding its scheduled use.
Our desire is that you will quickly and effectively learn to use Time & Chaos to manage your
time commitments.

Time & Chaos brings order to the three most common types of time-dependent information:
things you need to do (todo's); appointments you need to keep; and contacts you want to
make on a regular basis. On a single screen, you can see at a glance what you need to do
today, who you will be seeing, and who you might want to call or write.

You can instantly switch to any other day, to see what you did or what you will be doing.
Schedule recurring activities at various intervals, prioritize the things you need to do, group
and categorize your contacts. Print activity reports for any period, or export the data to a
file for use by other applications.

Time & Chaos will help you write letters and print envelopes, dial the phone, even schedule
a meeting of several other busy people. Its alarm clock will give you plenty of time to
prepare for an appointment, and instantly remind you who it's with.

This user guide explains step by step how to use Time & Chaos' intuitive and powerful
features to help you tame chaos and make the most of your time.

iSBISTER International, Inc.
1111 Belt Line Road, Suite 204
Garland, Texas 75040

Voice: 214-495-6724
BBS: 214-530-2762
FAX: 214-530-6566

CompuServe: GO ISBISTER
Internet:
For Technical Support: support@isbister.com

For Sales and Orders: sales@isbister.com

COPYRIGHT 1992-1996
All rights reserved, Printed in 1996



Licensing and Registration

License Agreement

Prospective customers are encouraged to evaluate an unlicensed version of Time & Chaos
for up to 21 days for the purpose of deciding whether the program suits their needs. At the
end of this 21-day evaluation period, a user must either cease using Time & Chaos or
purchase a license for continued use. Use of an unlicensed copy of Time & Chaos for more
than 21 days, or use of a licensed copy by any person or business other than the licensee, is
prohibited and a violation of international copyright laws.

Each licensed user of Time & Chaos is entitled to use Time & Chaos on more than one (1)
personal computer provided that it is for their use only.

If Time & Chaos is installed on a computer network each Time & Chaos user on that network
requires their own license.

Licensing brings the legal right to continue using Time & Chaos. You will receive a Security

ID code that will eliminate the "registration reminder" screen that begins to appear after an
unlicensed copy has been used for more than 21 days.

Disclaimer of Warranties

iSBISTER INTERNATIONAL, Inc. does not warrant that Time & Chaos software will meet your
requirements or that the operation of the software will be uninterrupted or error free. Nor

do we offer any Warranties or Guarantees of any kind. You are free to use Time & Chaos in
any way you see fit, but AT YOUR OWN RISK!

iSBISTER INTERNATIONAL, Inc. is not responsible for any problems or damage caused by the
software or that may result from using the software; whether licensed or not. This includes,
but is not limited to, computer hardware, computer software, operating systems, and any
computer or computing accessories. End user agrees to hold iSBISTER INTERNATIONAL, Inc.
and/or any persons associated with the creation of this software harmless for any problems
arising from the use of the software.

We regret having to place such a disclaimer in a piece of software. We have made every
effort to make this software product as efficient and accurate as possible; however, in a
world full of frivolous and ridiculous law suits, we have no alternative.

WE HOPE YOU ENJOY THE SOFTWARE and we trust that you will find it productive!

How to Register Your Copy of Time & Chaos

The registration fee for each copy of Time & Chaos is $29.95 + $5.00 (shipping and
?)?\lnLc\j(“Qgs)idents of Texas must add the 8.25% State Sales Tax.

For network quantities of 11 and up please call 214-495-6724 and ask for Sales.

Payment can be made by mail, by voice phone, FAX, or online.

By mail: send cash, checks, or international money orders payable in U. S. funds and drawn



upon a U. S. bank.

iSBISTER International, Inc.
1111 Belt Line Road, Suite 204
Garland, Texas 75040 USA

Sorry, we do not accept foreign checks drawn on foreign banks.

By phone: Visa, MasterCard, American Express and Discover are accepted: call 214-495-
6724

Online: there are three ways to register Time & Chaos online.

CompuServe subscribers can charge their Time & Chaos registration fees to their
CompuServe statements. Log on to CompuServe and GO SWREG. When prompted for the
SWREG ID, enter 49. You will then be able to download the latest version of Time & Chaos.
Your Security ID code will be sent to you via CompuServe mail when we receive notice of
your order from CompuServe. At this time SWREG only allows registration of the product.
If you wish to order optional items feel free to send us CIS mail with the information as
specified in Email Orders below.

The iSBISTER BBS (214-530-2762) will accept registrations by Visa, MasterCard, American
Express or Discover cards.

Internet or Other Email Orders

I. At our home page http://www.isbister.com we have a page dedicated to our company
store.

Il. Please Send the following information via Email and we will be happy to process your
order.

1. Complete Name and Mailing Address.
2. What you want to buy (inclusive of all options).
3. Credit Card Number with Expiration
(We accept Visa, Mastercard, American Express or Discover)
4. Any notes or special instructions you wish to accompany the order.

FAX: You can fax to us at 214-530-6566 your orderfrm.wri along with your credit card
information and we will ship the same day. We cannot reply back by fax.



Installation/Hardware and Software Requirements

Time & Chaos requires at least 900 kilobytes of disk space when it is first installed.
Additional space will be needed for the data files created to hold all of your contacts,
appointments, letters, notes, etc.

Time & Chaos requires Microsoft Windows version 3.1 or later and a 386 microprocessor
running in 386 Enhanced mode and VBRUN300.DLL (Visual Basic Runtime module). The

runtime module is free. If you do not have it, it can be downloaded from iSBIiSTER
International's BBS and many other online sources.

Installation
To install Time & Chaos automatically,

1. Start Windows

2. Place the program diskette in your floppy drive

3. Run the INSTALL.EXE program found on the diskette
You can run the INSTALL.EXE program from Program Manager or from File Manager. To use
Program Manager, select File, then select Run from the pulldown menu. In the dialog box
prompting for the name of the file to run, enter d:<path>\INSTALL.EXE, where d: is the letter
of the drive containing the program diskette, and <path> is the DOS directory/subdirectory

path in which INSTALL.EXE resides. For example, A\NINSTALL.EXE, or C:\TEMP\INSTALL.EXE.

To use File Manager, open a window displaying the program diskette's contents, then just
double-click on INSTALL.EXE to run the installation program.

The installation program will ask you to confirm or change the name of the subdirectory in
which Time & Chaos will be installed. The rest is automatic!

To install Time & Chaos manually, create a unique subdirectory anywhere on your hard disk
and copy all of the Time & Chaos files to that directory. Then use Windows' Program
Manager to create a Program Item icon to start Time & Chaos:

1. Select File from Program Manager's menu bar

2. Select New from the pulldown menu

3. Select Item to create an icon

4. Enter a Description for the item, i. e., Time & Chaos

5. Enter the DOS Command Line to find and run T&C40.EXE, i. e.,
C:\TCHAOS\T&C40.EXE.

6. Enter the name of the Working Directory in which Time & Chaos resides. This
Working Directory is used to 'steer' Time & Chaos to a default set of data files.

7. Select OK to create the Program Item

Starting Time & Chaos



Double-click on the Time & Chaos icon to start the program.

The first time you start Time & Chaos, it will let you know that it has created your data files;
it will prompt you for a name to identify your data. This name that you specify will appear on
the title bar at the top of Time & Chaos. These files will hold your appointment, todo, and
contact data, and will be in the subdirectory that holds your Time & Chaos program files.

If you are upgrading to a newer version of Time & Chaos, your existing data files may need
to be converted to a new format and reindexed. The new program will ask if you wish to
proceed with this conversion, which cannot be reversed. You should make backup copies of
your data files if for any reason you think you might want to revert to an earlier version of
Time & Chaos.



Understanding The Time & Chaos Main Screen

The Main Screen is divided into four parts. Clockwise from the upper left corner, they are
the Calendar, Appointments, Phone Book, and ToDo Items. The Calendar allows you to
navigate in time. Appointments and ToDo Items change each day, while the contacts in
your Phone Book are always at your fingertips.

The Calendar displays a full month at a glance. Click on any day, and the list of
Appointments and ToDo Items is automatically updated. To change months, click on the
single-bracket (< or >) buttons at the bottom of the Calendar. To change years, click on the
double-bracket (<< or >>) buttons. Click on Today to leap back to the present day, as
determined by your computer's system clock.

The Appointments list is used to summarize all of your scheduled activities for a given day.
You can add a Day Title to any date, to remind you of special days such as birthdays,
anniversaries, etc. You can add, delete, or search for appointments and review today's notes
by clicking on the appropriate buttons at the bottom of the Appointments list. Double-
clicking on any appointment item opens a window to additional functions.

You can assign color-coded icons to categorize or prioritize appointments, append notes to
an appointment, repeat an appointment at regular intervals, link an appointment to a
contact record, and set an alarm to alert you of an upcoming appointment.

The Phone Book, in the lower right corner of the Main Screen, provides easy access to all of
your contacts. Two data files (Yellow and White Pages) are maintained by Time & Chaos,
allowing you to keep separate files of personal and business contacts, frequent or irregular
contacts, or any other division you wish. Contact records can be moved back and forth
between the Yellow and White Pages files. Within each phone book, you can assign one or
more Categories to any given contact. Then, using the Search or filter function, you can
view one particular group of contacts at a time.



Using The Appointment List Section

The Appointment List found on the Main Screen includes five function buttons along its
bottom edge: Add Appointment, Delete, Search, filter, Add Day Title, and Notes for Today.
Other functions pertaining to a specific appointment -- its Description, Start and End Times,
Repeat Options, Notes, Linking & Alarms -- can be accessed by double clicking on any given
appointment shown in the list.



Add Appointments

Select the Calendar date on which you wish to schedule an appointment. Click on the Add
Appointment button to open a new Appointment detail window, like the example shown
below:

Time & Chaos assumes you want to add an appointment to the date selected on the Main
Screen Calendar. You can change this default Appointment Date by clicking on the down-
arrow to the right of the date box; this action displays a miniature Calendar from which you
can select a new date for your appointment.

The Start Time and End Time for the appointment can be set with the mouse or the cursor
keys or typing in a valid time. Clicking on the Up or Down arrows to the left of either time
adds or subtracts 30 minutes. The arrows to the right of either time change the time in
one-minute increments. The left/right cursor keys change the time in one-minute
increments, while the Up/Down cursor keys change the time in 30-minute increments. The
Tab and Shift-Tab keys can be used to switch back and forth between Start Time and End
Time.

Important: you cannot schedule multiple appointments with exactly the same Date and
Start Time; an error message will display if you attempt to do so. However, appointments
can overlap; for example, 9:00 - 11:00 a.m. and 9:05 - 12:00 can be scheduled on the same
date.

The Description box holds any text you enter to describe this appointment. This text will be
displayed next to the appointment time on the Main Screen's Appointment List.

Color Icons can be assigned to appointments to help you see at a glance what kinds of
appointments you have on a given day: blue for business, green for personal, etc. The
default color is white; click on one of the color icons to change it.

Drag-And-Drop Addition of Appointments

From the Main Screen, you can click on a contact in your Phone Book list, hold down the left
mouse button, and drag the contact to the Appointment List section. Releasing the mouse
button will then start the Add Appointment process. The phrase, "Meeting with <contact>
@," where <contact> is the name displayed in your Telephone List, will be added to the
Description box.

Creating an appointment with this drag-and-drop method also sets a Link between the
appointment record and the contact record in your Phone Book. Links allow you to quickly
summarize and manage all of your appointments with a given contact. See the Phone Book
section of this manual for details of Link functions.

Appointment Screen Action Buttons

Four action buttons appear at the bottom of the Appointment screen:

OK: saves the current Appointment data and returns to the Main Screen.

Delete: deletes the appointment from your Appointment List. If you have set any Repeat
Options, Delete will also erase identical appointments set for other dates. (See Repeat

Options
later in this section.)



Notes: activates the built-in Note Processor for editing or printing notes attached to this
appointment. The word "Notes" is highlighted in red if notes are already attached to this
appointment, and a lower-case "n" appears next to the appointment on the Main Screen's
Appointment List.

Cancel: returns to the Main Screen without saving any changes you have made to the
current appointment.

Appointment Index Tabs

The Appointment screen includes four index-tab buttons labeled Description (the default
screen when an Appointment is created or edited); Repeat Options, for duplicating an
appointment on several dates and setting the range of dates for a Group Delete (See
"Deleting a Group of Appointments later in this section.); Notes pertaining to a specific
appointment; and the Linking & Alarm functions.

Clicking on one of these index-tab buttons opens a new screen full of Appointment-related
functions. The Description screen is described immediately above; let's proceed to the
other three index-tab options.

Repeat Options Index Tab

Many of us have standing appointments, which occur at the same time but on multiple
dates. Time & Chaos makes it easy to add or delete a standing appointment in your
Appointment List. From the Appointment screen, first complete the Description portion of
the appointment (description, times, links, etc.). Then select the Repeat Options index tab.

Notes

Clicking on the Notes index tab opens a window in which you can add, edit, and view notes
associated with this appointment. To print your notes, or to use the other features of Time
& Chaos' Notes Processor, click on the Notes button at the bottom of the Appointment
screen.

Linking & Alarm

Clicking on the Linking & Alarm index tab opens a window through which you can set a Link
between an appointment and a Phone Book contact record, and set an Alarm to remind you
of an upcoming appointment. When you click on a linked appointment the linked name in
the telephone book will be highlighted.

Linking Appointments to Contacts

If you set a Link between an appointment and a contact record in your Phone Book, you will
be able to use the Phone Book to summarize all of your appointments with that contact
person. This Linking function is handy for viewing or printing reports of client activity, sales
contacts, and so on.

To set a Link for this appointment, first select the appropriate Phone Book (click to toggle
between White and Yellow Pages). Then click on the down-arrow next to the long, narrow
window in the illustration above to display a scrolling window of the contacts in the selected
Phone Book. Scroll through this list and select the appropriate contact. Time & Chaos links
this appointment to the selected contact.



You can also create a Linked appointment from the Main Screen. Select a contact from the
Phone Book and drag the cursor to the Appointment List section while holding down the left
mouse button. When you release the mouse button, a new Appointment window opens
with a link established between the contact and the appointment record. You can then fill in
the Appointment data as you wish.

Setting An Alarm for an Appointment

You can set an audible alarm to remind you of an upcoming appointment. Whenever you
enter the Linking & Alarm window, Time & Chaos automatically supplies a default alarm lead
time. The default alarm lead time is set in the Preferences Setup area (Select File,
Preferences from the Main Screen). You can change the alarm lead time for a specific
appointment by clicking on the down-arrow to the right of the alarm lead time window.

Time & Chaos must be running in order to notify you of an upcoming appointment. Alarms
rely on your computer's system clock, so be sure that the clock is set to the correct time.
Appointments whose start times have passed will not trigger alarms.

Deleting Single Appointments

You can delete any given appointment by clicking once on its entry in the Appointments List,
the clicking on the Delete button at the bottom of the Appointments List screen. You will
also find a Delete button on each of the four Appointment Detail screens: Description,
Repeat Options, Notes, and Linking & Alarm.

Deleting Repeated Appointments

If you used the Repeat Options to repeat the same appointment several times across your
calendar, you can delete all or some of the repeated appointments in a single operation.
Select Repeat Options from the Appointment screen. Select the repeat frequency that
specifies the interval between repeated appointments. Set the starting and ending dates
for the period in which appointments are to be deleted. Then click the Delete button on the
Appointments Screen. You will be warned that you are attempting a group delete, and you
will be asked to confirm this action before it is performed. Perhaps an even easier way
would be to do this from the SEARCH Screen. You can easily delete a group.



Appointment Category Filter Button

You can have your Appointment List display only appointments that fit into any or all of 18
predefined categories, such as business or personal appointments, telephone calls or
personal meetings, in-office or out-of-office appointments, and so on. You create these
Appointment Categories in the Preferences Setup area (Select File, Preferences from the
Main Screen).

Normally, Time & Chaos displays all appointments for a given day. Limiting your list to
appointments in specific categories is called filtering the list. You can easily filter your
Appointment List to display one or several different categories of appointments.

See Categories for implementation details.



Add Day Title

A Day Title is a brief description that applies to an entire day. Day Titles may be used to
identify special dates such as anniversaries, birthdays, and so on, or to remind you as you
review your Calendar that you will be engaged in some activity for several days in a row. To
add a Day Title to a specific date, click on the date in your Calendar and then click on the
Day Title button under the Appointments List.

You can change the date to which a Day Title is applied if you wish. You can also change
the color in which this date will be displayed on your Calendar. Note that Repeat Options,
Categories, and Notes can be used in conjunction with Day Titles, just as they are used with
Appointments.



Day Notes

You can attach notes to a date in your Calendar just as you can attach notes to
Appointments. Click on the Day Notes button at the bottom of the Appointments List to
activate the Notes Processor. Day Notes is intended to be a diary function. You can record
various comments, conversations and information bits that occur during a day. All of the

words that you type here are fully searchable later on.



Editing Existing Appointments

Editing existing appointments is easy. Just double-click on any appointment shown in the
Appointment List to open the Appointment Screen. You can then change any of the
information associated with the appointment. The Repeat Options can be used to repeat
the appointment on other future dates, or delete repeated occurrences of this appointment
for any range of dates.

You can move appointments from one date to another by dragging the appointment to a
date on the monthly calendar located on the main screen. This action will MOVE the
appointment. Alternatively, holding down the Control Key on your keyboard as you are
dragging will COPY the appointment to the date that you drop it on.

Should you wish to drag an appointment into the next or previous month, you can use your
Control Key in conjunction with clicking on the NEXT month button. This will change the
calendar, but not the displayed appointments thus allow you to drag to a new months date.



Using The ToDo List Section

The ToDo List is in the lower left corner of the Main Screen. ToDo Items can be assigned to
dates in the future as well as today. Any unfinished ToDo Items will appear on the next
day's ToDo List, so you will not forget them. You can rank each day's ToDo Items using
predefined priorities, so the most important or urgent ToDos are always at the top of your
list.

Categories can be created for ToDo Items just as they can be created for Appointments and
Phone Book contacts, allowing you to filter your list of ToDo Items. ToDo Items can also be
linked to Phone Book records, making it easy to summarize all of the ToDo Items connected
with a given contact, or to autodial the contact's phone number. You can search ToDo Items
to locate those items containing a search string.

You can now multi-select todo's on the main display for deleting or marking done. To multi-
select hold down the Ctrl key while clicking on the todo item.



Add ToDo Item

Click on the Add ToDo Item button to open the "ToDo Detail" screen shown on the next page.
Every ToDo Item must be assigned a Start date, which can be today's date or to any date in
the future. ToDo Items are automatically carried forward to the next day's ToDo List unless
they are deleted or marked Done. Only ToDo Items whose Start dates are equal to or less
than the current date will be displayed.

Each ToDo Iltem must also be assigned a priority, a one-character code which groups items
according to their nature or relative importance when your ToDo List is displayed. Time &
Chaos provides six priority selections: Critical, Important, Work It In, Pending, Telephone,
and Done. Critical items are displayed first, Done items last. Custom allow you to specify a
priority that is important for you. An example may be a priority of C1 or D55.

Hint: to further rank items within a priority category, remember that Time & Chaos displays
item descriptions in alphabetical order, after sorting items by priority. Thus, within your
group of "A" priorities, you can begin the description of each item with a number or letter
which will determine the order in which the item is displayed within the "A" group of ToDo
items.

Drag and Drop ToDo Items

You can create a ToDo item and link it to a contact in your Phone Book in one operation.
Just click on a contact in the Phone Book window, hold down the mouse button, drag the
cursor to any point in the ToDo List window, and release the mouse button. Time & Chaos
automatically creates a ToDo item and assigns a Telephone priority status to it. The ToDo
item's description will consist of "Call <contact name> @ <number>." The itemsin <>'s
are taken from the contact record in your Phone Book, using the contact name that appears
in the scrolling window and the phone number that appears in the Business Phone field. If
no business phone number is listed in the contact record, no phone number will appear in
the ToDo item.

You can edit any ToDo item created with the drag-and-drop method just as you can edit any
other item. Simply double-click on the ToDo item to open its ToDo Detail window, and
change whatever details you wish. Just like appointments you can drag a ToDo item to a
date on the monthly calendar on the main screen to either copy or move it to other dates.
The ToDo Detail screen appears whenever you add a new ToDo item or double-click on an
existing ToDo item in your ToDo List. The Detail screen lets you view or edit a ToDo item's
Description, Notes, Linking, settings, and Repeat Options. These five sets of ToDo features
are fully described under the topic ToDo Detail Index Tabs.

The ToDo Detail screen has four buttons along its bottom edge:

Update - saves any changes you have made and returns you to the Main Screen.

Delete - deletes an existing ToDo Item and any associated notes, then returns you to the
Main Screen.

Notes - activates the Notes Processor so that you can edit and print notes.
Cancel - returns you to the Main Screen without saving any changes made to the ToDo item.

ToDo Detail Index Tabs



The ToDo Detail window provides access to five sets of features through the index tabs found
along the top edge of the Detail window. The Description features are shown by default
when you create or edit a ToDo item. Clicking on one of the other index tabs provides
access to these additional features:

Notes - a mini-window in which you can view, edit, and add notes to a ToDo item. You must
use the Notes Processor to print notes.

Linking & Autodialer - lets you set a link between a ToDo item and a contact in your Phone
Book. Links allow you to summarize and print reports of past and future ToDo items
associated with any given contact. When you click on a linked todo the linked telephone
record will be highlighted in the main display. If you have a modem, you can also autodial a
contact's phone number while viewing a ToDo item. Links are automatically created when
you use the drag-and-drop method of creating a ToDo Item.

Repeat Options - lets you duplicate a ToDo item on multiple dates in your Calendar. The
Repeat Options are handy for tasks you must perform over and over again, such as
balancing your checkbook. Repeated ToDo items are not the same as a single, unfinished
ToDo item "carried forward" on your ToDo list. When you delete or mark any ToDo item as
Done, it will not be carried forward to the next day's ToDo list. But if the ToDo item has
been Repeated, it will appear again on the next date it is scheduled in your Calendar.
Repeat Options will detail the way to repeat the ToDo.



Done

You can quickly mark a ToDo item as completed without opening the ToDo Detail window.
Just click on any item in the ToDo List to highlight it, then click on the Done button at the
bottom of the ToDo List window. The item's priority will change to "Done," and it will move
to the bottom of your list. Items marked "Done" will not be carried forward to the next
day's ToDo List.

You can also multi-select todo items to be marked done by holding down the CTRL key while
clicking on the todo you wish to mark.



Delete ToDoO's

Deleting a ToDo item permanently erases its details and any notes associated with the ToDo
item. By contrast, items marked Done remain in the Time & Chaos data files, so you can
review past activity. To delete a ToDo item, click once on the item to highlight it, then click
on the Delete button. You will be asked to confirm your choice.

You can also delete a ToDo item from any of the screens available in the ToDo Detail window.
This provision allows you to review the details of a ToDo item before deciding to delete it.

If you are trying to delete a group of repeated todo items, you would do this from the
SEARCH screen. From the SEARCH screen select Description from the drop down box. In
the keyword box to the right of it type the todo description. When the search results are
displayed verify this is indeed the the group of todo's you wish to delete and then click the
Select All button. Once all records are highlighted then click the delete button. This will
PERMANENTLY remove the items from your database.

You can multi-select todo items for deletion from the main screen by holding down the CTRL
key while clicking on the todo's to be deleted



ToDo Category Filter Button

Normally, Time & Chaos displays all of the ToDo items for a given date, including any
unfinished items from previous dates. However, you can limit your view of your ToDo List by

assigning categories to ToDo items and then filtering your ToDo List to display only specific
categories.

See Categories for implementation details.



Using The Phone Book List Section

The Phone Book List is in the lower right corner of the Main Screen. Phone Books are used
to maintain information about your contacts such as their names, companies, addresses,
phone numbers, and personal information. Many people spend the majority of their time
working with Phone Book Lists. From the Phone Book List, you can write letters and print
envelopes, autodial phone numbers, and keep notes on your activities with clients and
acquaintances.

Contact records can also be the keys to organizing and reporting your Appointments and
ToDo items. Multiple Appointments and/or ToDo items can be linked to any given contact
record, allowing you to review and edit Appointments or ToDo items associated with a given
contact while you are using the Phone Book List, and to print activity reports sorted by
contact name.

Phone Book List Features

As seen from the Main Screen, the Phone Book List provides the following information about
contacts:

Scrolling Contact List: on the left side of the Phone Book List screen is a scrollbox in which
all of your contacts are listed in alphabetical order. The names shown in the list are taken

from the Name As Listed field of each contact record. You can scroll up and down through

this list using the mouse and the scrollbar to the right of the list, or use the following cursor
keys to navigate the list:

up/down arrows: move the highlight bar up or down one contact at a time

PgUp/PgDn arrows: move the highlight bar up or down ten contacts at a time

Ctrl-Home/Ctrl-End: jump to the first or last contact, respectively

Contact Phone Numbers

The righthand portion of the Phone Book screen displays additional information about the
contact highlighted in the contact list. Up to six phone numbers per contact can appear,
along with the contents of the FIRST NAME AND LAST NAME FIELDS and the COMPANY
FIELD..

Details of entering a Telephone Record.




Add Listing

Click on this button (or press Alt-L) to begin creating a new Phone Book record. A blank
Telephone Entry Detail window will appear, showing the six Index Tab Cards. The Overview
index tab card is displayed first. This card and all the others are described below, but first
let us look at the Edit option on the menu bar of the Detail window.

Edit Menu

Whenever you are in the Telephone Entry Detail window, you may select the Edit option on
the menu bar to perform one of the following functions:

Copy Primary Address to Clipboard

Copy Secondary Address to Clipboard

Clone This Entry
When Time & Chaos clones a Phone Book entry, it creates a new entry containing all of the
information in the original entry except the Name As Listed, which must be unique. You

must provide a new Name As Listed for the newly cloned record. It must be different from
any other Name As Listed in the current Phone Book.

Overview Index Tab Card
The first item to be defined is the Name As Listed. This name is the key by which Time &

Chaos indexes, locates, and sorts Phone Book records. A record's Name As Listed must be
unique; it cannot duplicate another key in the same Phone Book.

Time & Chaos automatically fills in certain fields in a contact record depending on how you
enter a Name As Listed.

Note: If no comma is found in the Name As Listed, Time & Chaos inserts the entire
Name As Listed text in the Company field. If you enter a comma in the Name As
Listed, Time & Chaos assumes you have entered a person's name in Last-name,
First-name order. The text before the comma will be inserted in the Last Name
field and the text after the comma will be inserted in the First Name field (on the
Contact tab).

After creating the Name As Listed, you can complete the business address information on
the Overview screen. (Secondary Address information should be entered on the Contact
information screen; click on the Contact index tab to access that screen.)

To the right of the Primary Address fields are six user-definable fields which can be used to
store items of information about a specific contact. The fields' labels can be customized by
the user; just click on a label and type a new label over it. However, changes made to
these labels in one Phone Book record will take effect on ALL Phone Book records. You will
be prompted to confirm that you wish to make this global change before it is made.

To the far right on the Telephone Entry screen are six fields for telephone numbers. They
are labeled Business, Home, Car, Fax, Pager and Other. The Car, Fax, Pager and Other field
labels are shown in red, indicating that you may change these labels if you wish. Such
changes are NOT global changes; they are made only to the labels on a given Phone Book



record.

Note: it is recommended that you include the area code of every phone number
when entering it, regardless of whether the phone number is a local or long-
distance call. Use either of these formats to enter a phone number: ###-#4##-
HH#HHE or (#H##) ###-####. But use only ONE of these two formats throughout
your Phone Books.

By consistently including the area code of every phone number, you can take advantage of
Time & Chaos flexible Autodialer and Preferences Setup features when traveling, when you
change long-distance companies, or when your telephone company changes the rules for
placing local and long-distance calls.

After completing the Overview index tab card, you may wish to complete the Contact index
tab card. Click on the Contact index tab to switch to the Contact index card screen. Its
fields and how to fill them in are described next.

Contact Index Tab Card

This screen is used to record and view information about a specific person. Fill in the first
and last names, title, salutation (Mr. John Smith, etc.), and other information you may have
about the person. The address fields on this screen are used to store an alternate address
for this contact person, usually but not necessarily the person's Home Address. Time &
Chaos refers to this alternate address as the Secondary Address throughout its other
functions (reports, letters, searches, etc.).

Notes Index Tab Card

This screen provides a mini-window in which you can quickly add, edit, and view notes about
a contact. To print notes or use the other advanced features of the Notes Processor, click
on the Notes button at the bottom of the Telephone Entry screen.

Categories Index Tab Card

Each Phone Book record can be assigned up to 18 categories. These categories can be
used in searches to locate records that belong to a given category or group of categories (i.
e., "Sales Reps" and "Southeast Region"); in filters to limit your view of the Phone Book List
to a specific group of contacts; or in Reports to print a report about a specific group of
contacts.

ToDo and Appointments Index Tab Cards

These two screens will display ToDo items and Appointments which have been Linked to a
contact record. Links are described in the ToDo and Appointments sections of this user
guide. You cannot create a Link from the ToDo or Appointment Index Tab Cards, but you can
view and edit any existing linked ToDo items or Appointments displayed on these screens.
Just click on any item displayed to open its Detail screen.

Attached Files Index Tab Card

'‘Attached Files' will give you the ability to associate documents and other items created by
applications external to Time & Chaos.




Telephone Entry Detail Buttons

While a Telephone Entry Detail screen is open, a row of buttons appears along its bottom
edge no matter which Index Tab Card is displayed. These buttons provide access to the
following features:

Update - saves any changes you have made to a contact record and returns you to the
Main Screen.

Delete - erases the current contact record and any associated notes from the Time &
Chaos data files, then returns you to the Main Screen.

Cancel - returns you to the Main Screen without saving any changes made to the current
contact record.

Notes - opens the Notes Processor, providing access to many features not available
through the Notes Index Tab Card. The word "Notes" will appear in red if any notes about
this contact record already exist.

The next four buttons are rapid navigation tools. The < and > buttons respectively move
backward and forward one record at a time in your Phone Book List. The |< and >| buttons
respectively jump to the first and last contact in your Phone Book List. These are LIVE
buttons; meaning that they automatically save the changes as it is moving you to the next
card. This you may find very handy for updating a group of records quickly.

Print Profile - prints a complete profile of the current contact record to the default
printer. The profile includes all of the information found on the Index Tab Cards, including
all appointments and ToDo items. All notes associated with the current contact record will
also be printed. However, notes associated with ToDo items and appointments will not be
printed.

Letter - provides access to Time & Chaos' WP Integration module. Time & Chaos
maintains a library of user created form letters, custom-written letters and/or merge
documents. You can automatically date and address a new letter or a letter already on file
with either the primary or secondary address stored in the current contact record.

Upon selecting letter you gain access to the WP Integration module. You will see a screen
labeled "WP Integration" .

Envelope - provides access to Time & Chaos' Envelope Printer . The Envelope printer can
print standard #10 business envelopes one at a time. From the Envelope window, you can
control the following aspects of envelope printing:




Category Filter Button

Normally, Time & Chaos displays all of the records in your database. However, you can limit
your view of your database by assigning categories to records and then filtering your
database to display only the records that are members of the selected categories.

See Categories for implementation details



Quick Search in the Telephone Book

You can quickly search your Phone Book from anywhere on the Main Screen. Just start
typing the first few letters of a Name As Listed that you want to find. The Phone Book List
will scroll to the nearest match it contains to what you type.



Move Phone Book Entries

Two Phone Books are provided so that you can keep your personal and business contacts
separate, or maintain separate sets of frequent and infrequent contacts. You can easily
move a contact record from the current Phone Book to the inactive Phone Book. Just
highlight the desired entry in the current Phone Book List and click on the Move-> button at
the bottom of the Phone Book List. You can move multiple phone entries concurrently, by
using your Control Key or Shift Key in conjunction with a mouse-click to select multiple items
in the telephone list. (it works just like file manager).

Copying Phone Book Entries

You can now multi-select and copy phone book entries from one telephone book to another.
Let's look at the following example.

Say you want to copy the 1st, 2nd and 5th records from the White Pages to the Yellow Pages.

1. Make White Pages your current telephone book (button in the lower right corner of the
T&C main display).

2. Hold down the Ctrl key and click on the 1st, 2nd and 5th records to highlight them.
3. Now hold down the Ctrl key and click ‘Move to Yellow' button.

This will copy the highlighted entries from the White Pages to the Yellow Pages.



Select Phone Book

Whichever Phone Book you are currently using (White or Yellow Pages), you can quickly
switch to the other Phone Book. Just click on the button at the far right end of the row of
buttons at the bottom of the Phone Book List screen.

If you are on a network, Time & Chaos can allow any group of users to share a common set
of yellow pages. Located in each users WINDOWS subdirectory will be a file with the name
of TCHAOS.INI - this file may be edited with NOTEPAD.EXE or similar editor. You could add a
line in this file (towards the bottom would be fine):

YPHONE=<PATH>

Where <PATH> is a valid path statement to the shared set of yellow pages.

YPHONE=F\CHAOS\MYCHAQOS



Dialing Phone Book Entries

If you have a modem, you can dial any of the phone numbers displayed for a given contact.
Click on the button to the left of a phone number to open the Autodialer window. Press the
Enter key or click on Dial button to immediately dial the phone number. Click on the Talk
button or press the Enter key again after you lift the receiver of your phone. The Autodialer
window will close, returning you to the Main Screen. |If there is no answer or the line is
busy, click the Hangup button to terminate the call before returning to the Main Screen.

Autodialer Features

The checkboxes in the Autodialer window control whether a number is dialed exactly as
displayed or modified before dialing; whether Time & Chaos will attempt to redial a busy
number; and whether an attempted phone call will be recorded in the Phone Log file.

At the top of the Autodialer window is a box showing the current phone number plus any
prefixes or suffix that will be dialed. Values for the Local Dial and Long-Distance Prefixes,
your local Area Code, and Long Distance Suffix are stored in the Modem section of the
Preferences Setup area. (Select File, Preferences, Modem from the Main Screen.)

Each time you click on a checkbox, something is added to or deleted from the phone
number. The phone number displayed will change to reflect the status of all the
checkboxes, so that you can see exactly what will be dialed. Following are descriptions of
each checkbox and their effects:

Local Dial prefix: adds a prefix to local phone calls if this box is checked. Such a
prefix might be a code needed to access an outside phone line from your office.

Long-Distance prefix: adds a different prefix to long-distance calls if this box is
checked. Such a prefix might simply consist of the number "1" or it might be a longer long-
distance access number.

Area Code: if this box is checked, Time & Chaos will compare the area code in the
current phone number to the Local Area Code stored in the Preferences Setup area. If the
two are identical, the area code will be stripped out of the current phone number before it is
dialed.

Long-Distance Suffix: adds a string of characters after a long-distance call is dialed,
if this box is checked. The suffix may be an accounting code used by your office phone
system to track long-distance calls by department or client.

Redial: if this box is checked, Time & Chaos will attempt to redial a number if it gets a
busy signal. The interval in seconds between redial attempts can be set by the user.

Log Call: if this box is checked, each attempted phone call will be recorded in a text file
named PHONE.LOG which is stored in the Time & Chaos main subdirectory. The PHONE.LOG
file contains one line per attempted call. Each line lists the date and time a call was
attempted, the phone number dialed, and the Name As Listed shown in the Phone Book
record.



Custom Report Writer!

From the Main Screen, click on the Report! menu option or press Alt-R to open the Report
window. The toolbar at the top of the screen lets you select the type of data from which the
report will be created; the Appointments data file is selected by default. Click on the ToDo,
White Pages, or Yellow Pages icon to use a different set of data.

Four index tabs provide access to Report functions. You must first Select or Create a report;
click on the Select/Create index tab.

Creating a New Report Format

Enter a name for your report format in the Report Name box, i.e., "Appointments for March,
1994." Any new report format you create will automatically be saved under this name.
Existing reports can be retrieved and used again. Click on the down-arrow to the right of
the Report Name box to display a list of available report formats, then double-click on a
report name to select a format.

Selecting Report Fields

Next, you must select which field(s) will be included in this report. The Available Fields
picklist on the left side of the screen displays the names of fields in the current data file.
The field names will be different depending on which data file you have selected
(appointments, todos, or phone book).

Double-click on each field in the Available Fields list that you wish to include in the report.
The name of each selected field will move from the Available Fields list to the Report Fields
list. Alternatively, you can click once on a field name to highlight it, then click on the
topmost single-arrow key in the middle of the screen (--->) to include that field in the report.
To quickly select all Available Fields, click on the topmost double-arrow key in the middle of
the screen (--->>).

You can remove fields from a report by a similar process. Double-click on a field name in
the Report Fields window to remove it from the report format. Alternatively, you can click
once on a field name to highlight it, then click on the lower single-arrow key in the middle of
the screen (<---) to remove that field from the report. To quickly remove all Report Fields,
click on the lower double-arrow key in the middle of the screen (<<---).

Sorting Report Data

You can change the order in which the fields appear in each row of the report, after selecting
all of the fields to be included. Click on a field name in the Report Fields window to
highlight it. Then click on the Up or Down buttons to move that field relative to the others.
Field names are listed from top to bottom in the order in which they will appear in each row
of the final report.

Use the Sort by Column box to determine how the rows in a report will be sorted. Click on
the down-arrow to display a list of the Report Fields available. Click on the field name you
wish to use to sort the rows. When your report is generated, the rows will be sorted in
ascending order (lowest to highest value) of the field selected.

Selecting Records to Report



You can specify conditions which must be met by a record in order for it to be included in the
report. Click on the Record Selection index tab to open this window.

The first pair of boxes lets you set a range of dates. When the report is generated, only
records whose dates fall on or after the From Date and on or before the ThruDate will be
included.

The Field Content section of the screen lets you set conditions which must be met by the
content of a field in each record that is included in the report.

The first step is to select the Compare Field; this is the field in each record that will be
examined to see if it meets the conditions for inclusion in the report. Click on the down-
arrow key to display a list of available fields, then select one to be the Compare Field. The
compare field can be any field in the selected database it does not have to be on the fields
to be included on report.

The Field Value From/Thru boxes let you set a range of values between which the Compare
Field's contents must fall in order for a given record to be included in the report. For
example, if you chose the ToDo Priority as the Compare Field, you could limit your report to
ToDo items which are still unfinished and relatively important by setting the Field Value From
value to A (critical) and the Field Value Thru value to B (Important).

The Field Equals box can be used to select only records whose Compare Field exactly
matches a given value. If you want to report only finished ToDo items, you could set the
Field Equals value to X (done).

The Field Contains box can be used to search the Compare Field for a fragment of text, such
as a name or reference to a subject. If you wish to report only appointments with a specific
client, you could set the Field Contains value to the name of that client.

Categories can also be used to select records for reports. Click on the checkbox next to a
category to place an X in its box. You may select as many categories as you wish. Only
records whose assigned categories include those checked on this screen will be included in
the report.

Note: Categories use the AND or OR Logic. AND Logic means a record must be a
member of 2 or more categories to qualify for the report. OR Logic means a
record can be one or the other or even both.

Page Layout

The Page Layout index tab opens a window which lets you set the width and length of the
actual printed output; the margins within which data will be printed; the orientation of the
page (portrait or landscape); font name and font size. These settings apply only to reports
sent to the printer, not to exported ASCII or Excel data.

Execute Report

The Execute Report index tab selects the appropriate records, sorts them, and displays your
report in a tabular grid. You can use the scrollbars at the bottom and righthand edges of
the screen to navigate reports which do not fit on one screen.

Rearranging Column Order



You may find that you want to rearrange the column order of the report just click and hold
down with the left mouse button on the column header you wish to move and move the
mouse left or right to the position you wish the column to be and then release the left mouse
button. The column is automatically moved to the new position. This will come in handy if
you wish to have a secondary sort

Sorting Records

If you wish to sort by a different column you can double-click on the column header to sort
the report by that field. If you wish to have a secondary sort then you must position the
appropriate columns adjacent to each other (ref. Rearranging Column Order above). The
primary column should be on the left and the secondary on the right. Highlight a member
of each column by clicking and holding down with the left mouse button and dragging across
to the secondary column so that one member of each column is highlighted. Then you can
select from the column sort menu the appropriate sorting sequence.

Removing Data from a Report

To remove a row from your final report click on the row header on the far left. This will
highlight the entire row. If you wish to remove several adjacent rows click and hold down
with the left mouse button and drag the pointer over the row headers you wish to remove.
With all selected rows highlighted either select Delete Current Row from the Edit menu or
use the Ctrl+R key combination.

To remove a column position the cursor on a field in the column to be deleted. To remove
several adjacent columns click the left mouse in a field of the column to be deleted and
holding down the left mouse button and drag it across the other columns you wish to
delete. This should highlight several adjacent columns in the same row.  With all selected
columns highlighted either select Delete Current Column from the edit menu or use the
Ctrl+N key combination.

Note: you are only excluding data from the final report, not deleting data from
the data files.

Printing a Report
Click on the printer icon at the top of the screen to print the report.

Exporting A Report to a File

Time & Chaos can export your report data to a comma-delimited ASCII text file. Click on the
"mail label" icon to the right of the printer icon to export data. You will be prompted for a
file name in which Time & Chaos will write the exported data.

Many other programs can import data from files created by Time & Chaos, making it much
easier to transfer data from your phone books to a mail-list manager or word processor.

In a comma-delimited ASCII file, each record takes up one row. Each field in the record is
represented by a pair of double-quote marks (""). Fields within a record are separated from
each other by a comma. A typical line in such a file might look like this:

"Jones, Bill","Vice President","XYZ Corp.","12 Main
Street","Smallville","NY","10000"



Even empty fields must be represented by a pair of double-quote marks. For example, if Bill
Jones' title were unknown, the preceding record would look like this:

"Jones, Bill","","XYZ Corp.","12 Main
Street","Smallville","NY","10000"

The first row (record) in an ASCII file created by Report is called the field header record. It
consists of the names of the fields in each of the following records. The field header record
in our example might read

"NAME","TITLE","COMPANY","STREET","CITY","STATE","ZIP"

Some programs can use a field header record to automatically create names for the fields
they are importing. If your application does not make use of a field header record, you can
delete this record from the file.

Microsoft Excel Spreadsheets

You can export your report data to a Microsoft Excel(tm) spreadsheet and simultaneously
launch Excel. Just prepare your report in Time & Chaos, including removing any data and
sorting the records. Then click on the Excel icon to launch Excel and create a spreadsheet
containing the rows and columns in your report. The first row of the spreadsheet will
contain the names of the fields in each record, providing convenient labels for your
spreadsheet's columns.

Note: If when you started the DDE link it does not seem to transfer the data then
you must be aware of two things. 1. Time & Chaos must be able to find
EXCEL.EXE in your DOS path statement in order to automatically launch Excel. 2.
Any autoexecute macros such as Wizards or spreadsheets that are loaded in the
XLSTART directory will stop the DDE link.

File Menu Selections

Save As a *.WKS Worksheet: Choosing this option will allow you to save the results of your
report in a *.WKS Lotus worksheet format. From there you may choose to export into other
readily available formats.

Save As Text File: Choosing this option will send the custom report results to an ASCII text
file. You will be presented with a dialog to path and name the text file.

Printer Setup: Will call the Printer setup dialog so that you can make any final printer
adjustments before printing.

Close: Will close the Custom Report Writer.
Edit Menu Selections

The Report window menu bar includes the Edit option, which lets you copy all or part of your
report data to the Windows Clipboard. You may then paste the Clipboard's contents into
another Windows Application.

To copy all of the report, select Edit and then Copy ALL to Clipboard.



To copy part of a report, first select the desired portion of the report with the mouse. Click
in one cell, hold down the left mouse key, and drag the cursor to highlight a rectangle
containing all the cells you want to select Now select Edit, followed by Copy Selected to
Clipboard.

To Delete Selected Rows from a report highlight the rows you wish to delete and choose this
option from the menu (or use the Ctrl+R) key combination.

To Delete Selected Columns from a report highlight the columns you wish to delete and
choose this option from the menu (or use the Ctrl+N) key combination.

Column-Sort Menu Selections

This menu allows for six possible choices of sorting depending on the data displayed. Your
options are:

Numerically Ascending
Numerically Descending
Alphabetic Ascending
Alphabetic Descending
Date Ascending

Date Descending

OUh WN K

Numeric, Text & Date describe the type of field data and Ascending and Descending describe
the direction of sorting.



Envelope Printer Settings

Note:
information properly.

You will need to make this help topic full screen to display columnar

To assist our customers here are some sample settings to aid you in setting up your printer
for envelope printing. These settings are set in the Control Menu on the Envelope Printing
dialog. Your Windows Control Panel Printers settings should be set to 8.5 x 11 Paper in

Portrait Orientation.

Printer

Brother HL630

0,0

Canon BJ200
Envelope

Canon BJ200EX
Envelope

Canon BJC 600
Envelope

Canon BJ820
Envelope

Epson Action Laser 1100
0,0

HPII

Envelope Manual
HPIIP

Envelope Manual
HPIIId

Envelope Manual
HPIlIsi

Envelope Manual
HPIIIP

Envelope Manual
HPIV L

Envelope

HPIV Si MX
Envelope

HPIV Plus
Envelope

HP Desk Jet
Upper

HP500

Upper

HP520

Envelope

HP550C

Envelope

IBM 4029 (Lexmark)
Manual 1.5,0
Sharp JX-9400

Manual 0,0

Default
Orientation

0,0
0,0
0,0
0,0

0,0

Print Position

Adjustment
Default Bin (X,Y)
Landscape Envelope
Portrait
0,0
Portrait
0,0
Portrait
0,0
Portrait
0,0
Landscape Envelope Manual
Landscape
Landscape
Landscape
Landscape
Landscape
Landscape
0,0
Landscape
0,0
Landscape
0,0
Portrait
-0.005, 0
Portrait
0,0
Landscape
0,0
Landscape
0,0
Landscape Envelope
Landscape Envelope



Note: If you have a printer that is not on the list and it is working great with this
version of T&C give us a call with your envelope printer settings and we will add
them to the list so they can be shared with everyone.



I Need More Space in My Telephone Notes!
One particular useful application for the telephone attached files feature might be this.

Bearing in mind that each note in T&C is limited to 32K you may come up with more notes
against a telephone record than you can store.

How about this. In the notes processor you have the ability to store your notes as an ASCII
text file (In the notes processor file menu).
1. Save your existing notes as a text file.

Example: C:\CHAOS40\MYNOTE.TXT

2. Attach MYNOTE.TXT to its proper telephone record using the attached files feature in the
telephone detail screen.

3. Once this file is attached and you have tested it you can then delete the existing batch of
notes and have another 32k worth of space available to you and yet you still have all of your
previous notes.

Remember you can have up to 50 attachments per telephone record.



Printing Configuration Screen!

When you go to print any of the several reports in Time & Chaos you will be presented with
the Printing Configuration Screen. The title bar of the screen will present you with the type
of report you are printing. For Example: If you are going to print the "Current ToDo List"
the title bar of the print dialog will read "Print Current ToDo List".

The Printing Configuration Screen is divided into three tabbed areas. Page Layout, Print
Options and Printer Setup.

Page Layout

Printer Orientation
This part of the page layout lets you determine if you want your output in either Portrait or
Landscape format.

Font Name and Size

This lets you select fonts from your Windows list of available fonts. To change the font
name click the drop down box and scroll to the font name you wish and then click onit. To
change the font size, highlight the old size with the mouse and type an new size.

Optional Header Text and Font Size

This box lets you add optional text for a report header. This will use the same font as the
text of the report as specified in the font name selection but we allow you to change the size
of the report header by highlighting the existing font size with the mouse and then typing in
a new size.

Actual Output Dimensions

These parameters determine the exact output dimensions of the printed text. The width
is the exact width you would like to see your text. The length is the exact length you would
like to see your text. The top and left settings are the margin settings you wish to have.
These dimensions can be shown in either inches or millimeters. This is determined by your
setting in File|Preferences Setup.

Popular Default Settings

On the right hand side of the Page Layout tab are four buttons labeled with popular output
default sizes. Senior, Junior, Filofax, and Pocket. The blue shaded portion of the icon
represents the size of the output in relation to an 8.5 x 11 sheet of paper.

Save Page Layout
This button will save the currently defined page layout for future reference.

Print Options

Alphabetic Page Breaks?

Alphabetic Page Breaks are applicable to the Telephone and Address Book Reports. This
option is grayed out when printing other reports. With Alphabetic Page Breaks on you have
the option to print only one letter per page. Default value is False.



Example: All telephone entries that begin with the letter 'C' will be on one or more pages
by themselves.

You also have the option to specify the letter range to print. Let's say that you would only
want to print entries that begin with 'A' through 'M'. You would specify 'A' (w/o quotes) in
the from range and 'M' in the through range. Default values are 'A' through 'Z'.

Optimize Paper?
This option is designed to give you the ability to print more than one report page per sheet
of paper if your page layout settings allow. Default value is YES.

Print How Many Periods?

This option is to allow batch printing for various reports. Let's say for example that you
would like to print 5 weeks of weekly reports. The header above the field would show
weeks. Highlight the number in the field and then key in the value you wish. If our
example you would key in 5.

Printer Setup

This tab will show you all of the currently defined printers to your Windows session. If you
wish to change any of the settings on the printer then double click on that entry and it will
take you to the Windows Printer Setup. You can also change the default printer from this
tab.

After you have completed filling out all of the information on the Printing Configuration
Screen you tell the printer to print the job by clicking on the Print Button. If you change
your mind and decide you do not wish to print this job then select the Cancel button.



Calendar Information

Number of Days Since the First of the Year and Number of Days
Remaining

If you take your mouse and hold it over a day on the calendar at the main display and then
right click with the mouse the Appointment Title Display will change to " Day N With N1
Remaining" . Where N is the number of days that have elapsed since the first of the year
and N1 is the number of days remaining until the end of the year.

Example: Right clicking on March 01, 1995 the appointment title would change to: Day 60
with 305 remaining.



Drag & Drop From Todo's to Appointments

Have you ever had a telephone call that you just had to make at a specific time. Well, in
Time & Chaos if you show that Todo as a telephone call and you want to you can drag the
telephone todo and drop it on the appointment display. You can now set an alarm to remind
you to make the call at a certain time. T&C will forward the telephone icon and any
associated notes. Just as in the ToDo's the telephone keys will turn black when there is an

associated note.



Deleting Repeated Appointments & Todo's

As you use Time & Chaos you may have an occasion where you wish to delete an
appointment and/or todo that you have repeated. Let's use an example of deleting a
repeated appointment. Similar logic will apply to the todo's.

Step 1. Go to the search button under the appointments display. (All fields should be
displayed in the drop down field selector box)

Step 2. Change from All Fields to Description in the field selector.

Step 3. In the keyword field immediately to the right of the field selector type in the

description of the appointment that you have repeated.

Step 4. Click the Find button. This should find all of the repeated records and display
them in the search results screen.

Step 5. Click the Select All button.
Step 6. Click the Delete button. This will permanently remove the records from your

database.

You can now enter a new repeated Appointment or Todo.



Open/Create Calendar Set

A calendar set consists of all the related information that you can access at one time
through Time & Chaos' Main Screen: Phone Books, Appointments, ToDo items, and their
associated notes. At any given moment, you can work with just one calendar set.

However, you may wish to create and manage multiple calendar sets; perhaps to keep your
personal and business data separate, separate customers from internal employees, or even
manage several different businesses' contacts using Time & Chaos. Whatever your needs,
there is no limit on the number of calendar sets you can manage with Time & Chaos.

Each calendar set consists of identically named data files. Since two files of the same name
cannot exist in the same DOS directory, Time & Chaos requires and helps you to create a
separate subdirectory for each calendar set you maintain. Time and Chaos also keeps track
of which calendar sets are in which directories, and lets you assign an easily remembered
description to each calendar set.

Opening an Existing Calendar Set

Open the File pulldown menu and select Open/Create Calendar Sets. Time & Chaos will
display the Open Time & Chaos Files screen, showing the descriptions and locations of
available calendar sets.

Double-click on the desired description to open that calendar set; or, you may click once on
the desired calendar set and then click on the Open Calendar button. You do not need to
close the current calendar set; Time & Chaos does that automatically.

Creating a New Calendar Set

Open the File pulldown menu and select Open/Create Calendar Sets. Time & Chaos will
display the Open Time & Chaos Files screen.

To create a new calendar set click the button 'Create a New Calendar Set'. This will present
you with a dialog to create a new directory in which to hold the calendar set. This new
directory will be a sub-directory of your current Time & Chaos directory. It requires a valid
8.3 DOS file name. After you have created the sub-directory to hold the data Time & Chaos
will ask you for a name to call the data. This can be anything up to 30 characters in
length. Time & Chaos will then create the new subdirectory, build a new, empty set of data
files in the subdirectory, and switch to the newly created calendar set. The description and
location of this new calendar set will be added to the list of calendar sets on the Time &
Chaos Files menu.

Browse

The Browse button presents you with a directory browser which will let you browse the
current Time & Chaos directory for existing data sets or ones you may receive and wish to
add it to your Files List.

To manually install an existing calendar set: Create a subdirectory in the current Time &
Chaos directory to hold the calendar set files. Use Windows' File Manager or the DOS
MKDIR command to create the subdirectory.



Copy the calendar set to the new subdirectory.

Start Time & Chaos. Open the File pulldown menu and select Open/Create Calendar Sets.
Time & Chaos will display the Open Time & Chaos Files screen.

Click on the Browse button to display a Find A Calendar Set browser. The highlighted
directory in the directory tree window shows your current position in the directory tree. You
may navigate up or down the directory tree by clicking on directory names above or below
the highlighted directory. Switch to the directory that contains the calendar set you wish to
add to your Files List. The description of the calendar set will appear on the title bar of the
window. Click on the OK button.

Network Connect (Multiple Instance)

Time & Chaos is "LAN ready" the moment you install it. The same calendar set can be used
concurrently by multiple users across a LAN, without loading the DOS SHARE.EXE command.
Options in the Preferences Setup area allow but do not require password protection for read,
write, and read-write access to your calendar set by other users on a LAN.

You can also open more than one calendar set at a time using Network Connect. To load
another calendar set across a LAN or on your local workstation, select File from the menu
bar, then select Network Connect.

The Network Connect screens look and act like the Open/Create Files screens. The
difference is that when you open a calendar set through Network Connect, you actually
launch another copy of Time & Chaos to manage the additional calendar set. As the
additional copy of Time & Chaos loads, the copy from which you opened the additional
calendar set shrinks itself to an icon on your Windows desktop. The new copy of Time &
Chaos also shrinks to an icon after loading the new calendar set. Each icon is labeled with
the description of the calendar set it manages, so you can easily switch from one calendar
set to another.
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ASCII Import to Telephone Book

Data from other programs can be imported into Time & Chaos Telephone Book data files IF
you carefully follow the directions in this section.

1. The data to be imported can be in a user defined file name.

2. The data must be in either Comma Delimited ASCII (with or without quotes) or Tab
Delimited ASCII format, one record per line. Every record must contain the same number of
delimited fields, even if some fields are empty. This means if you can get the data into
Excel 5.0 then you should be able to get it into the Time and Chaos telephone book as Excel
5.0 produces a reliable Tab Delimited Export.

3. The first record (line) in the user defined file must contain delimited field names for all of
the fields in following records. This is called the Field Header Record.

Here's an example of a Comma Delimited ASCII file ...

"Company Name","Business Phone","Contact"
"Acme Plumbing","","John Jones"
"Wilson Hardware","814 321-0976","Ralph Smith"

Notice several things about the example shown above:

1. Every field begins and ends with a double-quote character.

2. Every field is separated from the next field by a comma.

3. Even fields which hold no value, like the empty phone number field in Acme Plumbing's
record, are represented by a pair of double-quote characters with nothing between them.

4. There may be blank spaces embedded in fields (between pairs of double-quote
characters)

5. There cannot be any blank spaces between fields and the commas which separate them.
6. Each record must be a single line in the file; it cannot "wrap around” to the next line.

If you must manually edit the user defined file, use a word processor or text editor that can
save the file as ASCII text without wrapping long lines. MS Windows NotePad and the DOS
Editor work well for this purpose.

After you have created your data file, save it using any name you wish.

Load Time & Chaos. Select File from the menu bar, then select Import ASCII To Telephone
Book. Time & Chaos will display the Import ASCII Delimited File screen. Next click on
either the Comma Delimited ASCII or Tab Delimited ASCII radio buttons. Now you to match
up the data fields from your user specified file to the corresponding data fields in Time &
Chaos' phone book records.

The field names contained in the first record of the user specified file will appear on the left
side of the split screen. The Time & Chaos phone book field names will appear on the right
side of the screen.

First click on a user specified field name to select it. Then click on a Time & Chaos field
name to match it up with the first field name. Remember to first click on a field name in the
left half of the screen and then on a field name in the right half of the screen. Continue
matching up fields from the user specified file with corresponding Time & Chaos fields.

If you have fields in your user specified file that do not correspond to any of the fields in



Time & Chaos' phone book records, click on the Disregard Field entry on the right of the
screen to tell Time & Chaos that this import field is to be ignored.

When you have finished this matching process, click on the OK button to start the import
process. When this process ends you will be returned to Time & Chaos' Main Screen. The
newly imported entries will appear in the Phone Book List like any others.



Backup/Restore Data

These two options on the File menu let you safely and easily make backup copies of your
Time & Chaos calendar sets, and restore any backup copy to the current working directory.
When you select either option, you will be prompted for a valid pathname in which to place a
backup copy or from which to restore a backup copy to the current working directory.

Important Things to Know about Backup/Restore!!!,

1. When you backup you are backing up the CURRENT CALENDAR SET ONLY.

2. When you backup DO NOT backup two different calendar sets to the same destination.
Each calendar set must be backed up on a discrete floppy or discrete sub-directories on the
floppy or in discrete sub-directories on the hard drive. Backup will OVERWRITE any data on
the destination device.

3. When you restore your data you will OVERWRITE your existing calendar set.

Note: If you wish to merge data from two different databases you may wish to
consider our product ArcMerge on the Time and Chaos Utility Disk. See
orderfrm.wri in your Chaos directory for details on the utility disk.

Please DO YOUR BACKUPS! This backup feature is important to use if your data has any
value to your at all.

Suggestion: You may wish to grandfather your backups. That is to say, use one floppy disk
for Monday, Wednesday, Friday and Sunday, and a different diskette for Tuesday, Thursday
and Saturday. After 30 or so backups it might be a good idea to reformat your floppies as to
insure clear sectors on the disk

If you see the error message "Unsafe to perform backup at this time....", it is generally
caused by one of the following conditions.

1. You have a second copy of Time and Chaos running that has a lock on the same calendar
set.

2. You are on a network and someone else has a lock on the same calendar set.

3. You may have a bad floppy diskette.

4. You may have a bad floppy diskette drive.

Note: when you restore a backup copy, it overwrites any calendar set currently
in use. This can be very handy for keeping 2 machines in synch with each other,
such as a work and home computer.

Multi-Disk Backup
If your data has become so large that it is no longer possible to store on one diskette, Time
& Chaos will prompt you to add additional diskettes until the backup is complete.

Note: The Time & Chaos multi-disk backup will not work if you have any one file
that is greater than the size of a 1.44 mb floppy. If you have individual files that
exceed the 1.44mb size you can A) Backup to an alternative sub-directory on your
hard drive or B) Archive the data in your existing files to get the file size below
1.44 mb capacity. You may wish to consider our product ArcMerge on our Utility
Disk.




Save/Reset Screen Location and Size

The Time & Chaos window can be resized and repositioned, just like any other Windows
application window. The Save and Reset options on the File menu allow you to save the
current location and size of the Time & Chaos window.

The Reset Screen to default sizes means to restore the factory default settings of Time &
Chaos (upper left corner of the display).



Print Menu
The Print option on the menu bar opens a menu of predefined reports you can print:

Current ToDo List
This will print the current ToDo list that the calendar is positioned on. Undone ToDo's are
carried forward on the printed report however on the display they show only on the day
they start displaying on calendar and the current day as defined by your system clock.
ToDo notes are included on this report.

Telephone Book
This report will print the current telephone book. It will display the name and all telephone
numbers for the record.

Address Book
This report will print the Primary and Secondary address in addition to all of the telephone
numbers for the current telephone book.

Daily Calendar
Will print the day title, appointment information with notes (if any) for the day that Time &
Chaos is currently positioned on.

Weekly Calendar
Will print a display of your appointments for the current week that Time & Chaos is
currently positioned on. Notes are not included in this report.

Monthly Calendar
This will print appointment time and description for the current month that Time & Chaos is
currently positioned on. Time & Chaos will endeavor to put as many appointments in the
display as possible. You must realize there is a limitation to the number of appointments
that can be displayed in the printed area. For best results in this printout use as brief a
description as possible in the appointment description.

Daily Calendar/ToDo List
Will print the todo list, day title, appointment description and time allocation for the day
that Time & Chaos is currently positioned on. Notes are not included in this report.

Telephone Profile
The telephone profile will print the primary and secondary address, contact tab
information, telephone fields, custom fields, categories, linked todo's, linked appointments,
and telephone notes.

Note: If any Category filters are in effect when you print a report, only the
records which match the Category filters will be included in the report. This
feature gives you greater control over the content of each standard report.



View!

The View! menu option provides a convenient calendar-like overview of your time
appointments for an entire day, week, month, or year. You can also add, delete, or edit
appointments from this window.

The current month is displayed by default. You can view an entire month at a glance by
clicking on the Month-View tab at the top of the screen. To see more appointments on a
particular day from month-view just single click with the left mouse button on a particular
day. The day area will expand. To reduce the area just left click once again. To see the
Day's Appointments from the month-view just double click on a particular day. You can
adjust the size of the font used to display appointments from 3.00 to 12 points.
Click on the calendar with your RIGHT MOUSE BUTTON to display a list of
available sizes, then click on the desired size. You can use the navigation tabs to the
right to move the months forwards or backwards.

Click on the weekly-calendar tab to the left of the Month-View tab to restore the Week-View
display. You can navigate forward or backward one week at a time using the scrollbar on
the righthand edge of the window, or by pressing the PgUp and PgDn keys. To see the
Day's Appointments from the week-view just double click on a particular day.

To see the year-view display click on the year-view tab to the right of the month-view tab.
This will display the current year. You can use the navigation tabs to the right to move the
years forwards or backwards. To see the Day's Appointments from the year-view just
double click on a particular day.

The Day-View window lets you add, delete, or edit appointments. Just double-click on any
existing appointment or on the Add Appointment button to open an Appointment Detail
screen. All of the index tab options described in the Add Appointment section of this
manual will be available.

When you are finished working with the View! window, select the Close tab to return to the
Main Screen.



TimeBar and Group Scheduling!

The TimeBar menu option provides a graphical overview of your appointments, and can also
overlay this view with views of other people's appointments. This feature makes it easier to
schedule meetings between several people.

When you select TimeBar from the Main Screen menu, Time & Chaos presents a grid with
the days of the month shown across the screen (each column equals one day) and the hours
of each day shown down the screen (each row equals a one hour time slot). The times of
each day during which you have scheduled appointments are shown in red; all other time
slots are white. Time & Chaos uses the Start and End times of appointments in your calendar
set to determine which portions of the grid should be shown as "unavailable."

Adding A Group Appointment

On the righthand side of the TimeBar screen is a list of all the calendar sets to which you
have access, including other network members. If you double-click on another calendar set,
TimeBar will overlay a new grid showing the availability of the person who owns that
calendar set. A different color will represent times when the other person is unavailable.
The remaining white space in the grid represents times when both persons have no
scheduled appointments. You can then determine when it might be convenient for them
to meet.

Multiple calendar sets can be compared in this way to schedule group meetings. When you
double click on a graph, you will see the details of your appointments only, you can only
view the time allocation of others but not the details of their appointments. If you would
like to add an appointment you will add it to all of those calendars that are currently
superimposed. Additionally there is an Add Group Appointment button that will allow you to
add a group appointment to all calendar sets that are active on the Time Bar.

Adding A Group ToDo

To add a Group ToDo just overlay all members of the network that you wish to assign the
ToDo on the TimeBar grid. Click the Add ToDo button. This will display the ToDo Detail
dialog which you can complete as normal. When you click OK on the ToDo Detail then it will
be added to all members that are currently active on the TimeBar.

Printing the TimeBar Display
To print a copy of your TimeBar screen, choose the Print icon. This is a screen dump to the
printer. There are no configuration options available.

Refresh Button
Click on the Refresh icon to re-paint the display. Refreshing is sometimes necessary if you
add several calendar sets to a TimeBar.

Administration Menu

Make Distribution List of Selected Users

To make a distribution list of selected users just hilight the users from the network member
list (lower right portion of the screen) and then take the Administration menu selection to
create the distribution list. You will be presented with a dialog to name the new Distribution
List. Once named when you select this Distribution List all members of that list will be
automatically hilighted and you can now take normal TimeBar actions.



Delete Currently Selected Users

To remove users from the list just hilight the name of the calendar set you wish to delete and
select Delete Currently Selected Users from the Administration menu. This will remove the
calendar set from your list but will not delete it from the hard drive. To remove it from the
hard drive you will need to use File Manager or DOS commands.

Delete Distribution List

To delete a Distribution list you must first select it. Then you must select Delete Distribution
List from the Administration menu. You will then be presented with a dialog of Distribution
Lists ONLY. Hilight the list you wish to delete and select Delete Distribution List from the
Administration menu (a second time). You will then be presented with a confirmation dialog
asking you if you are sure you want to do this. If that is what you want to do click OK and
the distribution list will be erased. The members will still be on the network but you will
have to individually select them.

Disable This Menu
Selecting this menu option will remove the Administration menu.

For Details of Setting up a Network see Networking and Groupware.




Notes Processor

Time & Chaos' notes processor is invoked by clicking on the Notes button during normal
Time & Chaos activity. Clicking on the Notes button instructs Time & Chaos to display the
notes processing screen.

The title bar of the notes processing screen reflects the identifier of the associated Time &
Chaos data item (i.e., phone book entry, appointment, todo, etc.) Under the title bar of the
notes processor screen you will find a menu bar and a tool bar that will allow you to
complete your notes processing desires. Let's review the menu bar and then look at the
tool bar controls.

File Menu

New
Instructs Time & Chaos to clear the text area of the notes processor so that you can start the
creation of new notes. This will delete the current contents of the notes processor.

Save As Text File
Instructs Time & Chaos to store the current contents of the notes processor into a DOS text
file of your choosing.

Print
Takes you directly to the Printer Configuration Screen where you can customize your printed
output.

Printer Setup
Instructs Time & Chaos to invoke its printer setup capability. Refer to the Preferences Setup
Topic for details.

Exit
Instructs Time & Chaos to exit the notes processor.

Edit Menu

Cut
Deletes the selected text from the notes processor and places it on the Windows Clipboard.

Copy
Copies the selected text onto the Windows Clipboard.

Paste
Inserts text from the Windows Clipboard into the notes processor at the present cursor
position.

Delete
Deletes the selected text from the notes processor.

Select All
Instructs Time & Chaos to select all of the text currently in the notes processor.

Now let's look at the tool bar controls.



Font - Time & Chaos displays the currently selected font being used by the notes processor.
To select a different font click on the down arrow to the right of the displayed font. This
activates a drop down list of available fonts. Simply click on the font of your choice.

Font Size - Time & Chaos displays the currently selected font size being used by the
notes processor. To select a different font size click on the down arrow to the right of the
displayed font size. This activates a drop down list of available font sizes. Simply click on
the font size of your choice.

Date Separator - Instructs Time & Chaos to insert a date and time stamp into the
current text. This time stamp is always placed at the bottom of the current notes processor
text. Alt+D will also activate this. Ctrl+D will place the date stamp at the cursor location

Print Notes - Instructs Time & Chaos to print the current contents of the notes processor.
Time & Chaos prompts you for confirmation. The printed output of the notes is controlled
by the selections you have made in the Printer Configuration Screen.

Close - Instructs Time & Chaos to close the notes processor, save the current text and
return to Time & Chaos' main screen.



Custom Controls & Tools Used to Create Time & Chaos

Selling Time and Chaos as shareware means having to carefully monitor the overall file size
of our finished program. We work very hard to make it as small and efficient as possible.
As such, | pick our custom controls very cautiously. If you are a VB developer, you may find
yourself extremely frustrated with the huge DLL files required for the ACCESS Database, and
the OLE2 support DLL requirements are ridiculous! If this trend continues the whole world
will consist of off-the-shelf software only. These controls below are small, efficient and
backed with top notch support!

Software Source

The Database Engine that Time & Chaos uses is available commercially to programmers that
would like to be able access records directly. VB/ISAM MU is available from SOFTWARE
SOURCE. This is a small, fast, highly efficient engine that is fully networkable. Their
telephone number is 408-265-3384.

Video Soft

Video Soft produces the INDEXTAB controls and the FORM RESIZING that we used in Time &
Chaos. Their module is IlITAB.DLL These controls are highly recommended for any VB
developer. Very creative staff with top notch support. You can contact Video Soft in the
U.S. at 510-547-7295

Mabry Software.

Mabry Software has provided us all of the listbox tools. It is these tools that support the use
of bitmaped pictures and allows tab stops to be supported. Mabry Software produce an
entire portfolio of cleaver little VBX's. They provide source code with their controls at no
extra charge.

You can contact Mabry Software in the U.S. at 206-634-1443



Shared Yellow Pages on a Network

Any group of users can share a common set of yellow pages.....

Time & Chaos can allow any group of users to share a common set of yellow pages.
Located in each users WINDOWS subdirectory will be a file with the name of TCHAOS.INI -
this file may be edited with NOTEPAD.EXE or similar editor. You could add a line in this file
(towards the bottom would be fine):

YPHONE=<PATH>
Where <PATH> is a valid path statement to the shared set of yellow pages.

Example:
YPHONE=F\CHAOS\MYCHAQOS



Attention Software Developers

Time & Chaos is now a full DDE server application. What this means is....it is now very easy
for a software developer to write records into Time & Chaos's databases from other
programs, IN LITERALLY THREE LINES OF CODE. A developer can also send queries to the
telephone book databases with a partial field ie) part of a phone number, and be sent back
other information like an address. This opens the door for all kinds of new add on
applications and plug in utilities.

We have a software developer's kit available that makes all of this so very simple and we
would be happy to assist you. If you are a software developer interested in such
capabilities.

To qualify for our Software Developers Kit (SDK) you need to address the three issues below.

1. Itis possible at the DDE level to cram bad data types in T&C databases, therefore You
must assure us that you will be respsponsible for data validity for your application.

2. We want to know a little about your intended application and how it may will benefit
iSBISTER.

3. The SDKis furnished AS IS. We do not charge for it and we do not support it or TAKE
questions on it. This is a small VB app that shows you how to create a valid DDE string to
access the Time & Chaos fields.

If you answer these questions and either fax or email us with your complete name, address,
telephone number and email address to the attention of Technical Support @ iSBISTER.

Once we are satisfied with your answers we will contact you with the password to download
the SDK from the BBS at 214-530-2762.



Drag & Drop - Appointments & ToDo's

Did you know that one of the best ways to create linked appointments and todo's is to drag
and drop them from the telephone book. By dragging a number out of the telephone book
and dropping you automatically create a link.

Once you drop the number on either the todo's or appts you can change any attribute of the
record as normal.

Now you ask what benefit would that give me?

Well once you have todo's and appt's linked you can go to the telephone detail screen and
by clicking on either the todo tab or the appointments tab you can see all of the todo's and
appointments linked to that telephone entry from a centralized location. This is handy if
you have several items linked to a particular entry and you wished to review the status all
on one telephone call.



Category Subdivide:

This can be one of the most exciting features of Time and Chaos. The purpose of this is to
allow you to sub-divide your particular database into a logical unit of work. The mechanics
of the category sub-divide is common to all databases. To try and further elaborate let's
look at the following example using the telephone book categories:

Setup of Categories:

We allow 18 independent, user definable categories for all 3 of the major databases in Time
and Chaos (Appointments, ToDo's & Telephone Books - Note: White and Yellow pages share
the same categories). These are defined by going to File|Preferences Setup and clicking on
the appropriate category tab. Then you fill in one of the 18 fields with your chosen category
name.

Just for fun let's say you want to make up a category in the phone book and call it "Family".
So we go File|Preferences Setup and go to Phone Categories and Type "Family" in one of the
blank fields (w/o quotes).

Next Step: Go to a family member in the telephone list box and double click on their name.
This will bring up the Telephone detail box. Now click on the tab that says Categories. This
will show all of the Categories you can now link this to. Click once on all of the categories
that you would choose to link this to. Yes, one entry can be linked to several different
categories. The category box should now have an X in it. This means that this telephone
entry is now linked to one or more categories.

Note: If you have many telephone entries you wish to add categories to them
while you are in the Category Telephone detail screen you can click the Advance
to Next Record Button (>) and you will go to the next record without having to
open and close telephone records. When you select (>) Time and Chaos writes
that record to file so you don't have to click the update button for that record.

Use of Categories:

Now that we have created and linked categories How Do We Use Them? We'll let's take this
example one step further.

Suppose your daughter is getting married and you would want to call all of your family
members and let them know.

Click on the white Filter button below the telephone list box. This should bring up the
category sub-divide list box. Click on the category you wish to sub-divide into. For our
example choose Family.

Time and Chaos now temporarily sub-divides your telephone book into only family members
(and turns the color of the phone book blue). You can now call them without having to search
them out of your major telephone listing. Once you have completed your calling you can
once again click on small box (which is also now blue), make sure all categories are
unchecked then click OK and it will restore your telephone book to it's original state (white
or yellow).

Similar logic applies to the categories for the ToDo's and Appointment's.



Be as creative and detailed as you wish. This tool is here to assist you and help you be as
efficient as possible in your busy schedule.

AND/OR Logicical Operators
When specifying multiple categories Time & Chaos allows you to use the logical operators
AND and OR.

If you select the AND operator that means for a record to display it must be a member of
both This category AND That category. If it is not a member of both categories it will not
display.

If you select the OR operator that means for a record to display it can be either a member of
This category OR That category but it does not have to be a member of both.

Note: It is possible to save your sub-divided phonebook to call on startup by
clicking an 'X' in the Save Selection for Startup Indicator in the Category Filters
dialog box for people that have several thousand records in their telephone book
this may cut down in some of the load time.



Envelope Printing

Envelope - provides access to Time & Chaos' Envelope printer. The Envelope printer can
print standard #10 business envelopes one at a time. From the Envelope window, you can
control the following aspects of envelope printing:

Print - click on this icon to print an envelope after you have set it up.

Close - click on this icon to exit the Envelope printer and return to the Telephone Entry
screen.

Primary/Secondary Address - click on the Primary or Secondary icon in the upper right corner
of the screen to select the current contact record's Primary or Secondary address for
printing. The contact person's name will always appear at the top of the address.

Comment Line - directly above the contact's address on the simulated envelope is a box in
which you can enter a comment to be printed on the envelope, i. e., "Urgent!". Or, if you
have a POSTNET type font (This font is not supplied with Time & Chaos), you can use this
field to print the US Postal Bar Codes.

Return Addresses: the Envelope module can store two return addresses. Select the
Primary Return Address button, then enter the primary return address in the window at the
upper left corner of the simulated envelope. To save this return address, select Control from
the menu bar, then select Save Return Address. To store a secondary return address, select
the Secondary Return Address radio button, then repeat the process used to enter and save
the primary return address. The radio buttons can then be used to select which return
address (or none) will be printed on an envelope.

You can also enter a return address to print on a single envelope, then exit the Envelope
printer without saving this return address.

Fonts - the contact address, comment line, and return address can be printed in different
fonts. To change the font of any item, first position the cursor anywhere in the item panel.
Then click on the down-arrow to the right of the font name window, to open a list of
available fonts. Select a font, then select a size for the font in the next window.

Using the Envelope Menu Bar

There are two menu bar items in the Envelope printer window, Control and Edit:

Control - from the menu bar, select Control to display a list of the following functions:

Sample Envelope Print Settings

Save Return Address: saves the current contents of the Return Address field, as the primary
or secondary return address depending on which radio button is currently selected.

Primary Address: copies the Primary Address from the current contact record to the address
field on the simulated envelope.

Secondary Address: copies the Secondary Address from the current contact record to the
address field on the simulated envelope.

Default Printer Orientation: sets landscape or portrait mode for printing envelopes.



Default Bin for Envelopes: selects which type of feeding mechanism will be used for
envelopes; options include manual feed and tractor feed as well as several laser printer bins.

Print Position Adjustment: lets you adjust the positioning of text printed on the envelope.
If text is being printed too close to the left edge of the envelope, increase the X-axis offset
value. If text is being printed too close to the top edge of the envelope, increase the Y-axis
offset. Decrease the offset values to position text closer to either edge of the envelope.
These values can be adjusted in inches and tenths of inches. The X and Y offset values are
stored by Time & Chaos for use only with the Envelope printer; they do not affect other
Windows printing applications.

Printer Setup: lets you select one of the printer drivers available through Windows' Print
Manager.

Print Envelope: prints the current contents of the simulated envelope to the selected
printer. Clicking on the Print icon at the upper right of the Envelope screen will perform the
same function.

Edit - from the menu bar, select Edit to display a list of the following functions:

Cut - copies selected text to the Windows Clipboard and deletes the text from its original
position.

Copy - copies selected text to the Windows Clipboard and leaves original text intact.
Paste - inserts text from the Clipboard at the current cursor position

Delete - deletes selected text.



F8 Quick Record Add

Sometimes in data entry you would like to just keep adding records without having to OK the
record and reopen a new screen.

In Time and Chaos if you are adding or updating a record and you wish to create a new
record without going back out to the main display then press F8 and Time and Chaos will
write the current record to file and open a new record for you to start adding data.



Word Processing Integration (WP Integration)

Time & Chaos now has a new relationship with the three major Windows word processors.
This module has been completely redone to make it easier for our customers to create
letters and do merges for letters and labels. As the major word processors already have
existing routines that do merges and labels very well we felt we could best help our
customers by making it as easy as possible to get their valuable data from Time & Chaos to
their word processor.

We support the Windows versions of AmiPro 3.x, MS Word 6.x and Word Perfect 6.x for all of
the functions in the WP Integration and we support other Windows word processors for the
Address NEW and EXISTING letters. DOS word processors are not supported.

WP Integration is accessed via the telephone detail screen and clicking on Letter or by right
clicking on a highlighted telephone record, or from the telephone search results dialog you
can click on Mail Merge Letter. For the WPIntegration to function properly you must have
your word processor defined in your File|Preferences Setup|Editor Tab.

The WP Integration module is divided into three tabbed areas.
Basic Letter

User Templates

Mail Merge Data File

Basic Letter - Allows you to either Address a new or existing letter using the Primary or
Secondary address. If you are going to Address a new letter you do not need to fill out the
'Document Name for Existing Letter' field. If you are going to address an existing letter
then you must insert the complete DOS path and file name to the existing letter in the
'Document Name for Existing Letter'. We have added a directory browser at the end of field
to assist you. Time & Chaos will send only lines of the address that have values in them.
Blank lines in the address will be ignored.

NOTE: At this point | want to mention that if you have any auto-executing
macros on startup these will interfere with this procedure. Please make sure
these have been disabled before continuing with this procedure.

User Template - is designed to work with the merging features of the major three word
processors mentioned above. When you wish to do a merge you must first have a
template to merge too. If you do not have one then you must declare the full DOS path and
file name in the 'User Template Name' field. To assist you in creating this path we have
added a directory browser at the end of the field. Once you have the path and file name
click the 'Create/Edit User Template' button and this will start the word processor and bring
up the merge document. You can then refer to your word processing manuals or on line
documents for inserting merge fields.

Once you have the merge fields established you can finish out the body of your document as
you wish. Then Save the document so that you now have your completed merge template
stored to disk and exit the word processor.

You should now be returned to the WP Integration module. If you wish to merge the person
and/or persons currently selected you can now click the 'Merge to User Template' button. If
you wish to re-select the person(s) to merge you can exit the WP Integration module and re-
select form the main display or telephone book search results screen. See Doing a Merge
for step by step example.




Send Output To - allows you to send the output of your merge to either a Document on disk
or direct to the Printer. If you have a lot of graphics in your template you may want to
consider sending the output to the printer otherwise output to document usually works well.

Output Document field is an optional field. It is to be used during the merge operation. It
stores the results of the merge in your word processor format. If no output document is
stored then Time & Chaos will assign a temporary one.

Create/Edit User template - this button calls your word processor and loads the document
specified in the User Template field. Once the document is loaded you can now build your
template. In MS Word or WordPerfect you will notice a new menu bar that will allow you to
INSERT merge fields into your documents. In AmiPro you will have to go Edit|Insert|Merge
fields. See your word processor documentation for details on inserting merge fields.

Merge User Template - this button will initiate the merge of your data from Time & Chaos
into the template declared in the User Template Name field and put the results into the file
which is named in the Merge Output Document field.



Creating a Merge Template & Doing A Merge

Important! To successfully do a merge you must first have the path to your word
processor properly declared in your Preferences Setup. This is done on the
Editor Index Tab.

In the course of everyday events you may find it beneficial to have predone templates for
which you can send data to be merged and produce a document.

Perhaps the best way to explain this is to work through an example. Let's say you are a
business person and as you solicit new accounts you would like to send them a Thank You
letter for their first order.

The first thing you want to do is to get the data (field headers) for the template. An easy
way to do this is to click on the Time & Chaos telephone book search button. In the Phone
Book Search display make sure that the phonebook icon of your choice is selected and that
"All Fields" is in the Field selector and the Keyword field is blank. Now click the Find button.
This will display a list of all entries in your telephone book. Now click on the first record in
the display and highlight it. Next hold down the Shift Key and press the End Key. This
should highlight the remainder of the records in the list.

Now click the Mail Merge Letter button. This will bring up the WP Integration module .

Now we need to give our template a name. We need to put this name in the User Template
Name field. We must specify the complete path to find this document.

EXAMPLE: C:\AMIPRO\THANKYOU.SAM

Now click the Create/Edit User Template button. This will activate your word processor and
call up your existing document.

NOTE: At this point | want to mention that if you have any auto-executing
macros on startup these will interfere with this procedure. Please make sure
these have been disabled before continuing with this procedure.

NOTE: At this point in creating the merge the control is passed to your Word
Processor. For step by step details in creating Merge Documents see your Word
Processor documentation or on-line help.

In MS Word or WordPerfect you will notice a new menu bar that will allow you to INSERT
merge fields into your documents. In AmiPro you will have to go Edit|Insert|Merge fields.
See your word processor documentation for details on inserting merge fields.

Select the Data Fields you wish to display on the template. For our example let's use:

First Name Last Name

Company

Primary Address 1

Primary Address 2

Primary City, Primary State, Primary Zip
Salutation

Then complete the remainder of the text you wish to include in your THANKYOU.SAM.



Now save this File|Save As|C:\AMIPRO\THANKYOU.* (Extension depends on your word
processor)

You can now close your word processor.
Congratulations! You have now completed your first template.
Now Let's Do An Actual Merge.

Assume we have three new people this week that had placed their
first order with you.

Brown, Mary
Jones, Mike
Smith, John

Go to the Phone Book Search display make sure that the phonebook icon of your choice is
selected and that "All Fields" is in the Field selector and the Keyword field is blank. Now
click the Find button. This will display a list of all entries in your telephone book. Now hold
down the CTRL + Click on the three names in your telephone list. Once these are
highlighted then click the Mail Merge Letter button. This will bring up the WP Integration
module.

Now that we have the WP Integration module up we are getting close. First make sure the
name of the template is in the User Template Field. You can either type this in or use the
browse button immediately to the right of the field. Next, if you wish to have a permanent
record of this merge then you can specify a file name in the Merge Output Document field.
You can do this by typing the complete path and name or use the browse button
immediately to the right of the field. If you do not specify a Merge Output document, the
WP Integration module will create a temporary one.

EXAMPLE:

User Template Name C:\AMIPRO\THANKYOU.SAM
Merge Output Document C:\AMIPRO\TEMP.SAM (Can leave blank)

Now we are ready to do the merge. Click the MERGE to 'User Template' button.

This will 1) Start your word processor. 2) Load the assigned template. 3) Do the merge.

4) Put the results in the Merge Output Document (either temporary or permanent) for your
review. You should now be looking at the completed merge document. You can page down
and look at the pages for your review or you can now tell your word processor to print the
document. You can now either Save the

Output Document or discard it.

NOTE: If you have any auto-execute macros that execute as soon as the word
processor is loaded this will most likely halt the sending of the address. If you
launch into a Merge and do not see the address sent then be on the lookout for
something like this. You will have to disable the macros for the Merge to function

properly.

Congratulations!! You have now completed your first Merge using the Time & Chaos WP



Integration module.



Attached Files

This feature will give you the ability to associate documents and other items created by
applications external to Time & Chaos. The Attached Files list box has a limit of 50 items
per telephone record.

You find attached files by double clicking on a telephone entry. This brings up the telephone
detail screen. The attach files processor is located on the 'Attached Files' tab.

When you open the Attached Files tab you will notice two buttons. Add and Modify. Click
the Add button.

You will now see a form with three fields, two browse buttons and five command buttons.

The uppermost field is the '"Attached File Description’ field. The contents of this
field will be displayed in the main viewer on the Attached Files tab. You can assign any
name you want to this field so it will be more meaningful to you. For example, if you are
keeping an Excel spreadsheet on your own record in the telephone book you may want to
attach it to this entry.

EXAMPLE My personal spreadsheet in Excel 5.0.

Data File Name

Next you will have to specify the complete path and file name to the file you wish to attach.
You can either type this in or use the browse button immediately to the right of the field.
EXAMPLE C:\EXCEL\MYDATA.XLS

Note: At this point if you browse and you have an association for the extension,
the Application Launch Command Line (EXE File) will be filled in for you.

Application Launch Command Line (EXE File). This is the complete path to
the executable program that will do the work. It will be passed the Data File Name as a
command line parameter.

Now that you have all of the fields properly filled in click the Save button to store the
association. You will now be returned to the main Attached Files display.

Clicking Modify on the Attached Files display will let you modify the Name or Path of the
highlighted entry.

Attached Files Command Buttons
Done - Tells T&C you are finished and returns you to the main Attached files screen.

Save - Tells T&C you are finished, stores the association and returns you to the main
Attached files screen.

Update - Lets you update an existing record.
Delete - Lets you delete the current record.

Activate - Executes the commands in the Launch Fields and Data File Name field.






Client Codes

Client codes are used for dialing a specific code to bill a particular telephone book entry.
The client code is stored in the first user definable field. The user definable field is on the
overview tab which is part of the telephone detail screen.

You control the placement of the client code in the dial string by a 'tchaos.ini' setting.

Clientcodes=Front means the client code will be dialed before the main telephone
number.

Clientcodes=Back means the client code will be dialed after the main telephone
number.

By default the Time and Chaos dialer comes up with client codes checked on. If you do not
want the client code dialed for a particular entry remove the check in this box.



Multi-Select Copy Phone Numbers

You can multi-select and copy phone book entries from one telephone book to another.
Let's look at the following example.

Say you want to copy the 1st, 2nd and 5th records from the White Pages to the Yellow Pages.

1. Make White Pages your current telephone book (button in the lower right corner of the
T&C main display).

2. Hold down the Ctrl key and click on the 1st, 2nd and 5th records to highlight them.
3. Now hold down the Ctrl key and click ‘Move to Yellow' button.

This will copy the highlighted entries from the White Pages to the Yellow Pages.



File Menu Commands
The file menu selection opens to 10 specific file topic selections.

1. Open/Create calendar sets. This will let you either build new calendar sets or go to
existing ones.

2. Network Connect (Multiple Instance) . This is the same as Open/Create except that it
creates a second instance of Time and Chaos instead of working within the existing one.

3. Import ASCII to Telephone book . This selection will bring you to the screen where you
can map over you Import.txt file into your current telephone book

4. Preference Setup . This is where you have general Time & Chaos settings that give T&C
it's look and feel.

5. Printer Setup. This selection takes you to the Windows Printer Setup so you can
configure which printer will be used for Time and Chaos printing.

6. Backup Data . Backs up the current data set.
Note: This will overwrite whatever data is on the destination media.

7. Restore Data . Restores data from your backup source
Note: This will overwrite the existing dataset.

8. Save Screen Size & Location . Saves the existing screen size and location on the
display.

9. Reset Screen to Default Sizes. Resets the screen size and location to the defaults that
come with Time & Chaos.

10. Exit. Exits Time & Chaos and closes the program and all data files.

Note: If anytime you click on the File menu and the first selection available to
you is Import ASCII, that is a good sign that you are in a second session of Time
and Chaos. To have all File menu selections available you must be in the first
session of Time & Chaos started on your machine.



Drag and Drop to Future and Past Months
1. Position your calendar on the day of the appointment or todo you wish to move.

2. Hold Down the CTRL key while clicking the navigation buttons below the calendar (<<
< > >>). This will advance the month on the calendar while the appts/todo's remain fixed.
You can move this forward or backward as you wish. Move the calendar to the month you
wish to drag the appt/todo to.

3. Pickup the appt/todo you wish to move with the left mouse button and drag it to the new
day on the calendar. This will move the appt/todo to the new day.

Note: If you wish to copy an appointment or todo just hold down the control key
and drag the appt/todo to the new date. The copy requestor will prompt you to
be sure you want to do this.



Distribution Points for iSBIiSTER Products:

Internet mail can be directed to:
For Technical Support and mail: support@isbister.com .
For Sales and Orders: sales@isbister.com .

We have made a homepage for iSBISTER available to those with Web access.

ftp site allow for quick access to and downloading of our latest releases.

The address (or url) for it is: http://www.isbister.com

iSBiISTER BBS
Telephone Number 214-530-2762
3-14,400 nodes, F8N1,
Full Duplex
8 Data Bits
1 Stop Bit
NO PARITY
Recommend Emulation = ANSI, also support TTY & VT100/102
Recommend Download Protocol = Zmodem. Others supported also.

NOTE: This is a Wildcat 4.0 BBS (RIP Graphics are disabled).

CompuServe Information Service (CIS)
WINAPA forum

GO ISBISTER

Keyword search on iSBISTER

America On Line (AOL)

Links to our

Goto the Software Center. When you Search The Libraries check off All Dates and All

Categories and use the Keyword iSBISTER for your search parameter.



Telephony Application Programming Interface (TAPI)
** For those of you wondering about that TAPI option in the modem setup.....

TAPI is THE way of the future for your telephone! TAPI very tightly couples MS Windows95
(only) with your telephone. A company called CLEARWAVE COMMUNICATIONS (303) 223-
3873 has a new product out called "Intellect" that is a TAPI device.

Basically, it slaves in between your PC and modem. It provides a centralized autodialer for
windows, provides caller ID and call log functions (even calls that you dial with your
telephone!). It will even automatically screen your telephone calls! This stuff is nothing
short of amazing and it works hand in hand with Time & Chaos.

If this sounds interesting give them a call for more details. (Call 1-800-414-WAVE for
marketing/sales info or 303-223-3873 to speak directly with a company representative.)



Preferences Setup
The Preferences Setup option on the File menu provides access to global (system-wide)

settings and user-definable information used by Time & Chaos. These settings are logically
grouped on seven Index Tab Cards. Each card and its settings are described below:

Main Index Tab Card

These options include global look-and-feel settings as well as user-definable defaults.
General Orientation - determines whether dates and labels on such fields as ZIP (postal)
codes are displayed in U. S., Europe or U.K. Canadian format. With European format
selected the ZIP code will proceed the CITY, PROVINCE on the letter addressing and
envelope printing functions.

Printer Measurements - allows you to specify your page layout dimensions in either inches or
millimeters.

Time Display - determines whether times are displayed in 12-hour (9:00 AM) or 24-hour
(09:00) format

Iconic Clock - when Time & Chaos is minimized, its icon can display either the time or the
date, along with the description of the current calendar set.

Default on Start-up - determines whether the White or Yellow Pages Phone Book will be
loaded when Time & Chaos is started.

Default Day Start - determines the time that your day is assumed to start. This time will be
inserted by default in Appointment records and appear as the first time on TimeBar! and
printouts.

Default Alarm Lead Time - the default number of minutes before the scheduled starting time
of a n Appointment that Time & Chaos will sound an alarm if you select the alarm option.

Prompt for Backup on Exit - this checkbox, when enabled, will Tell Time & Chaos to ask you
to backup every time you exit the program.

Spinning Top When Minimized - When selected the Time & Chaos minimized icon will display
as a spinning top.

Modem Information Index Tab Card

These settings control how Time & Chaos communicates with your modem (if you have one)
and allow you to set variables used by the Autodialer.

Modem Com Port - must be set to the COM port used by your modem in order for Time &
Chaos to communicate with the modem. COM ports 1 through 4 are supported.

Windows Communications Type
Regular Modem - You will be using T&C and your modem to be dialing.

TAPI - You will be using a TAPI compliant hardware for dialing.



Local Area Code - enter the area code from which you will be using Time & Chaos. Be sure
to enter this area code in the same format used for area codes in your Telephone Book
entries: ### or (##4#).

Local Autodial Prefix - if your office phone system requires you to dial 9 to get an outside
line, enter the number 9 here. You can also enter any codes that you normally dial before
entering an actual phone number to place a local call, i.e., a calling card number of billing
code.

Dial Access - select touch-tone or pulse (rotary) dialing method

Long Distance Prefix - any digits you would normally dial before entering a long-distance
phone number. Usually, only the digit 1 is required. But if you must dial 9 to get an
outside line, you would enter 9~1. (The tilde character instructs your modem to pause half
a second after dialing the 9; this gives the phone system time to seize an outside line before
dialing 1 and the phone number.)

Long Distance Suffix - any digits you would normally enter after a phone number is dialed,
such as accounting codes or credit card numbers.

Editor Information Index Tab Card

On this screen you can specify the location and start-up command of your favorite word
processor, to be used in conjunction with Time & Chaos' letter-processing feature. Enter the
complete DOS path and executable filename for your word processor, i. e., C:\AMIPRO\
AMIPRO.EXE. The letter-processing feature is accessed through the Telephone Entry Detail
Screen.

Passwords Index Tab Card

The screen lets you define passwords for network security. If you choose to use passwords
you MUST specify BOTH a READ and a READ-WRITE passwords. These words CAN NOT be
the same word. Defining a READ password will allow others to read and view your data but
they may not make change. READ-WRITE access will allow others to make changes to your
data.

More Options Index Tab Card

1. Calendar Set Name allows you to change the name of the calendar set which is
displayed in the Time & Chaos title bar.

2. Alert WAV sound. This field allows you to specify the complete path and file name to a
WAV sound you may wish to use for Time & Chaos alerts. If you do not know the complete
path you can use the file browser by clicking on the filing cabinet icon at the end of the field.

3. Number of Days that an Undone ToDo will roll forward. This is a user specified field.
After the value in this field has been superceded undone ToDo's will no longer roll forward.

4. You can set an UPDATE REFRESH RATE, that will automatically cause T&C to reread your
database every 'n' minutes. This is very useful, if you have multiple people using the same
database at the same time. It will cause T&C to reflect any changes that other users have

made, even if you have not touched your computer.



Phone, ToDo, and Appointments Categories Index Cards

The last three index tab cards look identical, but their settings apply to three different data
files. The Phone Book, ToDo, and Appointments data files can each be assigned up to 18
categories. One data file's set of categories can be completely different from another's.

Any record in a data file can be assigned up to 18 categories. Assigning categories to
records lets you use categories as Search keys to retrieve records, or as filters to limit your
view of a list to records which have been assigned specific categories.



Quick Access Menus w/Right Button Mouse Click

You can bring up the quick access menu by highlighting an entry in one of the databases
and clicking with the Right Mouse Button. This will bring up a menu of actions you can take
associated with the selected database.

Appointments
Notes
Dial

ToDo
(A) Priority
(B) Priority
(C) Priority
Pending
Telephone
Done
Notes
Dial

Telephone Books
Copy Primary Address (w & w/o salutation)
Copy Secondary Address (w & w/o salutation)
Notes
Envelope
Letter
Print Profile

Month-View Screen
Change your font size.



Network Installation

Time & Chaos will allow you to drag & drop Appointments, ToDo's, Telephone Records, and
send inotes. To implement this change will require that Time and Chaos be set-up for a
client/server relationship as opposed to peer to peer.

l. Create the Directory Tree Structure.

EXAMPLE:

Suppose we want to install Time & Chaos on a network with the J: Drive as the server.
Create the tree structure below.

J: Network Drive

|
| CHAOS40 (Executables stored in here, STRONGLY RECOMMENDED, however they
can be stored locally if you wish)

|

| Matthew (User Datasets stored here)
| Mark .
| Luke "

| John "

You can use the File|Open Create selection to create the new datasets if they do not exist.

Il. Install Time & Chaos (Preferred on SERVER but can be
installed locally)

Time & Chaos will automatically place a NODE database in the J:\CHAOS40 subdirectory to
manage the workgroup users 1 level below itself.

Ill. The icons for each individual user should be changed to reflect
the correct path for both the command line and the working
directory (sometimes called startup directory) property.

Note: Given the example above the COMMAND LINE for Matthew's icon should
read: J:\CHAOS40\Tchaos.exe. The WORKING DIRECTORY property for Matthew's
icon should read: C:\CHAOS40\MATTHEW.

To Get Your Current Data Into The New Directory

1. If your data is currently on a local hard drive and your network can see the local drive
then Start T&C with the new icon properties and click on File|Restore and path back to the
old drive and directory where your data is currently stored. T&C will read the data from
your old directory and write it into your new directory.

2. If your data is currently on a local hard drive and your network cannot see the local drive
then you can copy *.is? + category.Ist from the local drive to the users new database on the
server, or you can do a backup to a floppy on the local machine and then do a File|Restore
from the floppy.

Finding Network Members



To see the members of your Time & Chaos network single-click in the gray background of the
calendar. The calendar will go away and you will have the Network Selection list. Thisis a
list box of network members.

Copy or Move a Record Across the Network
How to Copy a Record Across the Network

1. Highlight a name on the network.
2. Pick up a Todo, Appt, or Telephone Record and drag them over to the Network
Member Selection List and release them.

How to Move a Record Across the Network

1. Highlight a name on the network.
2. Hold down the Control key and Pick up a Todo, Appt, or Telephone Record and drag
them over to the Network Member Selection List and release them.

Sending an iNote

Just exactly what is an iNote? An iNote is a text message you can send from one Time &
Chaos member on the network to another. To send an iNote to another member on the
network just highlight their name from the Network Member Selection List and the click the
iNote button. You can key in your message and then click send. They should have the
message within 1 minute.



3rd Party Products That Work With Time & Chaos!

Business Card Scanning:

COREX Corporation manufactures a terrific product called CARDSCAN. The CARDSCAN
device will electronically scan business cards and import them directly into your Time &
Chaos telephone book. Please ensure that you request the attachment feature for Time &
Chaos. COREX is located in Brookline, MA, their telephone number is 617-277-5344 or 800-
942-6739.

TAPI Communications:

CLEARWAVE COMMUNICATIONS (303) 223-3873 has a new product out called "Intellect" that
is a slave in between your PC and modem. It provides a centralized autodialer for Windows,
CALLER ID and call log functions that will accurately track all incoming and outgoing
voice/data/fax calls. It provides an accurate call timer. (It will even log and time calls that
you dial with your telephone keypad!). It will automatically screen your telephone calls!.
Pop Telephone Records & more. This stuff is nothing short of amazing and it works hand in
hand with Time & Chaos. If this sounds interesting give them a call for more details. (Call
1-800-414-WAVE for marketing/sales info or 303-223-3873 to speak directly with a company
representative.)

Mortgage Management:

The Duncan Group has produced Mortgage Quest for Windows. This is a highly effective tool
for the Mortgage professional. It has an advanced sales automation tool with components
that include Campaign, Loan Cycle and of course the Award Winning Time & Chaos to aid in
contact management. Mortgage Quest will also allow you to create your own marketing
letters, flyers and newsletters or begin marketing today with over 100 pre-written marketing
letters. You can contact Mortgage Quest Inc. c/o The Duncan Group, 4510 Executive Drive,
Suite 200, Sand Diego, CA 92121, (800) 952-2702



When Contacting Technical Support

iSBISTER Technical Support is available via the following:

Telephone: we accept calls from 8:30am to 5:00pm CST at 214-495-6724. Listen to the
automated attendant for the correct number.

WINAPA Forum
BBS: 214-530-2762

Internet: support@isbister.com

IMPORTANT! If you ask us a question on one of the services we will answer on that
service. Please do not ask us to contact you at a different location. We simply do not have
the resources to handle messages twice.

When contacting Technical Support be sure you have the following
information.

Your name and security code number.

The version of Time & Chaos that you are running.

The version of Microsoft Windows that you are running.

Are you on a network or stand alone.

An exact description of your problem and the events leading up to it.
Is it consistently reproducible?

oukwNE

Other things that would be nice to know

* How Much System RAM?
* How Large is your Hard Drive?
* Swap File, Permanent or Temporary & How Big?

If you know the following functions they will assist you in your
interaction w/ Tech Support.

* Understand the difference between files and directories.

* Browse the directory tree structure using File Manager or Equivalent.
* Copy, Move and Delete files using File Manager or Equivalent.

* Find a DOS Shell (DOS prompt or command line).

Note: If you are not familiar with these please consult your Windows or
application documentation for complete instructions on the proper use of your file
management utility.



CURRENT CALENDAR SET is defined as the Current Appointments + Current ToDo's +
Current White Pages + Current Yellow Pages.



Optional Products

Additional Original Diskettes: $1.50 ea.+ Shipping

Time & Chaos User Manual: $6.50 ea.+ Shipping

Professionally Authored and Printed with Full Screen Shots. The reason this is sold as an option is
because we put the entire text of the manual into the on-line help system, yet some customers feel more
comfortable with a printed manual. Therefore we ask them to bear this cost. This helps us keep our
costs down so we can give you a more cost effective product.

Utilities Diskette: $15.95 + Shipping (Consists of the following 8 items)

Time & Billing - An easy to use system that integrates effortlessly with Time & Chaos. Just
define a Major Project and a specific task, then just tell Time & Chaos what your hourly rate
is and he will do the rest. It will even do consolidated reporting with the new Expense
Tracking module if you so choose.

Expense Tracking - Now you can easily track expenses day by day with Time & Chaos.
Allows for designating a Major Project and/or specific expense. And will do consolidated
reporting with the new Time & Billing module if you so choose.

ArcMerge

Data archival and File Merging Utility. Arc allows you to archive your Todo's & Appointments based on a
specific date. Merge will let you merge two like databases together alerting you to duplicate records that
have some difference.

DBASE Export Utility
Exports all of your T&C data to DBASE Standards

WinFax Pro Export Utility
Exports your T&C telephone book to a Dbase Standard with Winfax Pro headers. This makes it easy to
import the Dbase file into the WinFax Pro Telephone Directory.

MENU.EXE
Provides a 'Tools' menu within Time & Chaos to allow you build a menu of your favorite applications
directly from T&C.

ALARM.EXE
Monitors upcoming alarms without having Time & Chaos loaded.

DIALER.EXE
Quickly autodial and copies address information to the clipboard without having Time & Chaos loaded.



Using the Time & Chaos Search Capability

All four of T&C's databases have a Search Capability. The purpose of this topic is to give
you basic understanding of the Search Utility.

Search Actions Common to all Databases

You enter the Search screen from the Time & Chaos Main Display by clicking on the Search
button below the database you wish to search.

The first thing you will need to do is to tell Time & Chaos which field you want to search on.
All Fields is the default. If you wish to search a specific field the click the drop down box
where All Fields is displayed and select a different field to search. Once your field is
selected then you can type in the Keyword(s) or search string you may wish to search for. A
search string is simply a string of text characters -- a word, part of a word, or a phrase like
"lunch with."

Special Note: If you choose Categories as the field to search, a list of the categories will
appear. Click on the box next to each category that you wish to use as a search string. An
Xin a box indicates that a category has been selected. Only entries whose assigned
categories match all of those selected on this Search screen will be retrieved during the
search.

Now that you have a Field and a Keyword click the Find button and the Search engine will
find all of the records in that database that fit the requested parameters.

Example: Let's say | wanted to find all records in the telephone book that had XYZ Company in the
Company field. | would change the field to search from All Fields to Company (selection from the drop
down box). | would then enter XYZ as the Keyword to be searched. Next | would click the Find button.

After all of the results are found you next have to tell Time & Chaos which specific records
you wish to take action on. You do this by hilighting the records.

Selecting All Records

To select all records in the results display you can:

A) Click on the first record and then hold down the Shift key and press the End key.
or

B) Click the Select All button.

Selecting Partial Records in a Series

To select a subset of records that are all in a row just click on the first record you wish to

take action on and then scroll down to the last record you wish to take action on and hold
down the Shift key and click on it. This should hilight all the records in between the two

clicks.

Selecting Random Records
To select random records in the search results display just hold down the Ctrl (Control) key
and click on the records you wish to take action on.

Appointment, ToDo & Phone Book Common Functionality
1. Simply double-click on one of the items to open the database detail screen. You can

then review and edit the details.
2. You can delete them by clicking the delete button.



3. (NEW) You can select Copy Results to Clipboard from the Options menu to put the hilighted records
on the Clipboard.

4. (NEW) You can select Global Edits from the Options menu. This will bring up a display of
all the fields available to you for changing. Edit the fields with the new text and then click
Apply Global Changes. This will update the highlighted records with the new values.
IMPORTANT! Be sure you want all of the values changed before Applying the Global Changes. THIS
WILL REPLACE ALL DATA PREVIOUSLY IN THESE FIELDS!!! This is a POWERFUL option for
changing your records but if it is not handled properly it can create problems as quick as it can solve
them.

Unique Search Actions

Now that you have Searched and Hilighted your records you will want to take action on
them. Specific action depends upon which database is being searched and the fields and
options available. Below we will discuss the specific action of each database. Up to this
moment the searching and hilighting procedures are common to all four databases.

Telephone Books (Both White & Yellow Pages)

1. You can delete them by clicking the Delete button.

2. You can create a letter with the selected records address by clicking on the Letter button.
3. You can do a mail merge by clicking on the Mail Merge button. This will take you into
the WP Integration module and you can Do A Merge.

4 You can print an envelope by clicking on the Envelope button.

5. You can send the results to a comma delimited ASCII file by clicking on the Export ASCII
button.

6. (NEW) You can select Copy Results to Clipboard from the Options menu to put the hilighted records
on the Clipboard.

7. (NEW) You can take the results of a search and move them to the main display by
choosing Transfer from the Options menu or use the Ctrl+T key combination. This will allow
you the ability to use the pre-defined printed reports for that select group of entries.

8. (NEW) You can select Global Edits from the Options menu. This will bring up a display of
all the fields available to you for changing. Edit the fields with the new text and then click
Apply Global Changes. This will update the highlighted records with the new values.
IMPORTANT! Be sure you want all of the values changed before Applying the Global Changes. THIS
WILL REPLACE ALL DATA PREVIOUSLY IN THESE FIELDS!!! This is a POWERFUL option for
changing your records but if it is not handled properly it can create problems as quick as it can solve
them.

Appointments

Special Note: when searching appointment Descriptions, Time & Chaos also searches the descriptions
of any Day Titles you have added to your calendar. Likewise, any Notes for Today are included in
searches of appointment Notes.



Repeat Options

IMPORTANT: To fix a repeating Appointment or ToDo you need to tell Time & Chaos two
things. Both of these actions must be entered or you will create an error.

1) A Repeat Frequency or How often to repeat the action.
2) A Repeat Through or How far into the future to repeat the action.

Note: Time & Chaos does not maintain an intelligent link between created appointments or

todo's. This repeat action acts as a one time job to put the appointment or todo on the
calendar. If things change see global delete to remove the appointment or todo

Repeat Frequency

Birthdays/Anniversary - repeats the action annually and automatically fills in the repeat
through for 20 years into the future from the date the calendar is currently positioned on.

Daily - repeat the action once every day.

Weekly - repeat the once a week.

Monthly - repeats the action once a month on the same day that the calendar is now
positioned on. Example if the calendar is positioned on the 15th the action will be repeated
on the 15th of every month.

Same Day Every Month - repeats the action on the Day of the month relative to its position
on the calendar. Example: If you are currently positioned on the second Tuesday of the
month then the action will be repeated on the second Tuesday of each subsequent month of
the repeat through period.

Same Day Every Other Week - repeats the action on the same day as you are currently
positioned every other week or every 14 days.

Last Day of Every Month - repeats the action on the last day of the month regardless of
whether the month ends on a 28th, 29th, 30th or 31st.

First Weekday of Every Month - repeats the action on the first working day of the month.
Working days defined as Monday - Friday.

Last Weekday of Every Month - repeats the action on the last working day of the month.
Working days defined as Monday - Friday.

Repeat Through

This selects a drop down calendar to help you establish the repeat through date.

The single navigation buttons < > lets you advance forwards or backwards through the
calendar one month at a time. The << >> double navigation buttons lets you advance
forwards or backwards through the calendar one year at a time.

Once you reach the appropriate year and month just click on the date and Time & Chaos will
fill in the repeat through field with the appropriate date.



Exit

Selecting this menu option closes all data files and exits Time & Chaos. IT IS
IMPORTANT! that you exit Time & Chaos via Exit. If you have other 3rd party programs
that are closing your Windows apps for you you run the risk of losing data. A program that
does not terminate properly risks a lot.

You can select Exit from the File menu or you can use Alt+F to activate the file menu and
then X to select Exit. Either of these will close T&C gracefully.



Networking/Groupware

Using Time & Chaos in a workgroup setting.

In addition to providing excellent time management features for local PC users, Time &
Chaos was designed to function most effectively in workgroup settings. Members of a
workgroup can use Time & Chaos to help implement team solutions to various business
endeavors. Workgroup members can schedule group meetings, share phone book entries,
pass ToDo items to each other, copy or move appointments or simply send small messages
to their counterparts within the workgroup.

So what is our perspective of a workgroup?

Business Perspective ... a set of Time & Chaos users working together on common
business issues. These users may want to schedule group meetings, send small messages
to each other and generally share information stored within their individual Time & Chaos
calendar sets (i.e., Appointments, ToDo's and Phone Books) with each other.

Implementation Perspective ... a set of Time & Chaos users with common access to a
master file storage area on a given PC (generally a Server somewhere on the LAN). This
master file storage area is a standard DOS file directory and each of the workgroup
members would use unique DOS subdirectories one level below the master storage area to
store their individual calendar sets (i.e., Appointments, ToDo's and Phone Books).

How does one setup Time & Chaos for workgroup usage?

Let's review this in general terms ... someone agrees to function as the workgroup
administrator and installs Time & Chaos in the master file storage area mentioned above.
This can be done while working on the actual server that will house this master file storage
area or it can be done while working on any given workstation that has access to the master
file storage area.

Time & Chaos builds a launching ICON as part of the installation procedure. This ICON's
properties point to the executable program in the master file storage area and specifies the
master file storage area (DOS directory) as the working/startup directory. Thus, when Time
& Chaos executes, it knows where to locate its master file storage area and where to build
its workgroup "store and forward" database.

The workgroup administrator then uses Time & Chaos to create the individual calendar sets
for the various workgroup members. Actual details will be found later in this section.

The workgroup administrator must also go to each of the workstations used by the
workgroup members and create a launching ICON for their individual usage of Time & Chaos.
This launching ICON's properties should point to the executable program in the master file
storage area and specify this workgroup member's unique file storage area (DOS directory
one level below the master file storage area) as the working/startup directory. Thus when
each workgroup member starts Time & Chaos on their workstation it will access their
calendar set within the workgroup setting.

How does Time & Chaos implement its workgroup features?

Reviewing this in layman's terms ... Time & Chaos maintains a "store and forward"



database for the workgroup. Remember, this "store and forward" database was built in the
master file storage area mentioned earlier. Each time a workgroup member runs Time &
Chaos it checks this "store and forward" database to confirm the member's presence in the
workgroup.

New workgroup members are thus automatically logged into the "store and forward"
database.

Time & Chaos checks for pending messages (i.e., Appointments, ToDo's, Phone Book entries
and/or small messages sent by other workgroup members) for this workgroup member and
begins delivery of these messages. Each of these messages are presented by Time &
Chaos and the user is given an appropriate opportunity to deal with the message (i.e., the
user can accept or ignore Appointments, ToDo's and Phone Book entries being passed to
them from another workgroup member and can reply to general messages). Time & Chaos
continues to check for additional messages from other workgroup members on a one minute
interval ... the user can also check for such messages on a demand basis.

While using Time & Chaos, the user can select one or more individuals from the list of other
workgroup members and instruct Time & Chaos to send them information
(i.e.,Appointments, ToDo's, Phone Book entries and/or small messages). These messages
are stored in the "store and forward" database for subsequent delivery to the other
workgroup member(s) as they actively use Time & Chaos.

Time & Chaos' TimeBar features (please refer to the specific section on TimeBar) also
depend on this list of workgroup members maintained in the "store and forward" database.

Things that the workgroup Administrator can do !

In addition to the installation of Time & Chaos and the creation of the individual group
member's ICONs, the workgroup Administrator can exercise other Time & Chaos features on
behalf of the entire workgroup. Access to these features is provided via the Administration
Menu on the TimeBar screen of Time & Chaos. This menu of administrative features can be
selectively made available to any/all of the workgroup members.

The Workgroup Administrator can:

Make a Distribution List ... for the convenience of the workgroup, subsets of the
workgroup user list can be identified and offered to the workgroup as distribution lists.
Distribution lists make it easier to broadcast messages and other information to specific
parts of the workgroup.

Delete a Distribution List ... these convenient list(s) can also be deleted if and when
desired.

Delete Selected Users ... the workgroup Administrator may find it desirable to remove
individuals from the workgroup ... one or more members can be selected and deleted. This
only removes the group user's calendar set identifier from the workgroup database. This
does not physically delete the files that make up the group user's calendar set, this would
have to be done using the system's file manager or some other equivalent. If the
workgroup user exercises Time & Chaos in the workgroup setting at a later time then the
calendar set identifier will be automatically added to the workgroup database again.

Scan the workgroup database and perform house cleaning ... as members are added
to and removed from the workgroup database and as actual calendar set data files are



created and deleted, it is possible that some of the information in the "store and forward"
database will be invalid (i.e., calendar set identifiers will point to actual calendar set storage
areas that no longer exist or that no longer contain valid Time & Chaos data files). The
workgroup Administrator uses this feature to instruct Time & Chaos to remove any bad
pointers and any pending messages for invalid relationships from the workgroup database.

Disable the Administration Menu ... the above menu of workgroup Administrator
features is (by default) available to all members of the workgroup. This may or may not be
a desirable situation; thus, the workgroup Administrator can run Time & Chaos using the
launching ICON for each of the workgroup members (from their workstation) and instruct
Time & Chaos to remove this menu from its TimeBar screen. This decision is reflected in a
network.ini file found in each workgroup user's calendar set storage area. This may also be
done during the workgroup setup procedure as each group member's calendar set is created
(see the details later in this section).

Now that the basics have been covered ... let's look at the specifics on installation,
utilization and administration of Time & Chaos in a workgroup setting. We will also cover a
special case of using Time & Chaos for a workgroup setting on a single PC as opposed to a
workgroup setting on a LAN.

Installation and Setup of Time & Chaos for usage in a workgroup
setting.

It should be understood, that for the following detailed discussion, we have
concluded that the person acting as the workgroup Administrator is knowledgable
of DOS file structures and is knowledgable of the Windows system.

The workgroup Administrator should choose a particular PC on the LAN to serve as the
master file storage system for use by the workgroup and install Time & Chaos on this
system. The following detailed discussion of Time & Chaos installation and setup will be
easier to follow if we relate it to a specific workgroup definition. Thus, for this discussion,
we will be implementing Time & Chaos for a workgroup of six people. Three of the people
are in the Sales department and the other three are in the Support department. The
workgroup members are identified as follows:

Sales Support

Steve Jamison Mike Whittingham
Debbie Reft David Harms
Bev Jamison Bill Tiede

Steve will function as the workgroup Administrator.

The installation and setup will be done while working at Steve's workstation system and the
master file storage area will be located on Bev's system. Bev's system is known as drive L
on Steve's workstation, thus Steve will install Time & Chaos in a DOS directory of his choice
on Drive L. For this discussion we will use the DOS directory [tcadmin].

Now let's install Time & Chaos ... Steve places the Time & Chaos diskette in A drive on
his system and uses the Program manager to execute the Install program on the diskette.
Steve then overrides the "install to" location suggested by the install program and sets it to
[L:\tcadmin]. Upon completion of the file transfers from the diskette to the L drive, the
install program builds an iSBISTER Program Manager group and builds four ICONS within this
group. There is an ICON to launch Time & Chaos and additional ICONS for the Time & Chaos
Readme file, Time & Chaos Help file and for the Time & Chaos order form.



The properties of the Time & Chaos launching ICON were set by the Install program to point
to the program EXE file as [ L:\tcadmin\tchaos.exe ] and to point to the working directory as [
L:\tcadmin ]. Steve then edited the properties and added the word [ Admin ] to the end of
the description field. Successfully installed, Time & Chaos is used to begin the workgroup
setup procedure.

When Time & Chaos executed and did not find existing data files for its Appointments,
ToDos, etc. it automatically created empty ones and asked Steve to provide an identifier for
this new calendar set. Steve choose to called the calendar set [ Admin ].

Steve's next activity was to create new calendar sets for each of the actual workgroup
members including himself. This is done by using the Open/Create Calendar Set option
under File Menu on Time & Chaos' main screen.

The Open/Create option presents a small screen showing the list of current calendar sets
(only the Admin calendar set exist as this point). Steve then clicks on the [ Create a New
Calendar Set ] button and Time & Chaos helps him create a calendar set for the first
workgroup member. Time & Chaos prompts for a DOS subdirectory to be created below the [
tcadmin ] directory that will contain the new calendar set files and then prompts for an
identifier for the new calendar set. The first calendar set created was for Mike Whittingham
and his first name [ Mike ] was used for the DOS subdirectory and his full name was used for
the calendar set identifier.

Note that the calendar set identifier must be unique within the workgroup and is used to
identify the actual group member for later information exchange.

When Time & Chaos finishes building the new calendar set it places you in its main screen
with access to the new (empty) calendar set files.

Steve [ workgroup Administrator ] had decided to restrict the Administrator features at this
time and thus goes to the TimeBar function within Time & Chaos, opens the Administration
Menu and selects the option to disable the menu.

Steve now repeats his use of the Open/Create function to create new calendar sets for the
remaining workgroup members. In each case Steve also disables the Administration Menu
within the TimeBar function of Time & Chaos.

At the end of this setup procedure ... viewing the DOS file structure of the L drive
(master storage area for the workgroup) reveals the following ... there is a DOS directory
named [ tcadmin ] and one level below it there are DOS subdirectories named [ bev ], [ bill ]
,[david],[deb],[ mike], and [ steve ]. Each of these subdirectories contain Time &
Chaos calendar set data files as does the parent directory [ tcadmin ].

The last step in the Time & Chaos setup ... is for Steve [ workgroup Administrator ] to
visit the workstation system for each member of the workgroup and create a launching ICON
for their use of Time & Chaos within the workgroup environment. For each ICON Steve
provides a description, sets the ICON's command line property to point to the Time & Chaos
EXE file on the system housing the newly created DOS directory [ tcadmin ] and sets the
ICON's working directory property to point to the DOS subdirectory under [ tcadmin ] that
was specifically created for this workgroup member.

Time and Chaos is then started using the new ICON to verify its usage. Steve used the
Open/Create calendar set option to verify that each of the newly created calendar sets are
visible to the other members of the workgroup. Steve also checked the workgroup member



list (behind the small calendar in Time & Chaos' main screen) to confirm each users ability to
exchange information within the workgroup. Steve also checked the TimeBar function of
Time & Chaos to further verify that the workgroup members' calendar sets are available for
group scheduling.

Creating distribution lists for subsets of the workgroup.

Steve had been asked to create two distribution lists for the workgroup ... one for
members of the Sales department and one for members of the Support department. To do
this Steve restarts Time & Chaos using the ICON for his role as the workgroup

Administrator ... remember that the individual workgroup members had the Administration
Menu disabled ... and moves into the TimeBar function. Steve first selects all of the
workgroup members that are in the Sales department and the uses the Make Distribution
List option under the Administration Menu to instruct Time & Chaos to create a distribution
list for these selected workgroup members. This distribution list is called [ Sales ]. Steve
then selects only the workgroup members that are in the Support department and creates a
distribution list called [ Support 1.

Steve could have created additional distribution lists as desired. Workgroup members can
be within multiple distribution lists; thus, Steve could have created a distribution list called
[ Everyone ] or one called [ Order Processing ], etc.

Well ... each workgroup member may now begin their use of Time & Chaos.

What about existing Time & Chaos data ?

If some or all of your workgroup members were already using Time & Chaos in stand alone
environments, they most certainly will want to bring their calendar set of information with
them to the new workgroup setting. This is handled very easily !

Here's what we suggest ... have each workgroup member access Time & Chaos in their
old environment ... have them use the Backup Data option under the File Menu to store their
calendar set information for movement to the new workgroup environment. For simplicity
have each workgroup member backup their data to a diskette. Now have each workgroup
member access Time & Chaos in the new workgroup environment and have them use the
Restore Data option under the File Menu to copy their calendar set data from the diskette to
their new storage area within the workgroup environment. An alternative is to have each
workgroup member simply use the Backup Data option to store their old calendar set files
directly into their new storage area within the workgroup environment via their network
access capabilities.

Information exchange using the workgroup features is a snap ... or should we say a "drag"
and a "drop" !

Workgroup features are accessed from the main screen of Time & Chaos. Your first step is
to select the target audience for your information exchange ... this can be an individual
workgroup member, a distribution list or a specifically selected subset of the workgroup
member list. The list of workgroup members (including Distribution lists, in any) is hidden
behind the small calendar in the upper left hand corner of Time & Chaos' main screen. To
expose this list simply click on the grey background surrounding the small calendar.

With the audience for your information exchange selected, you simply "drag" Appointments,
ToDo's or Phone Book entries over to the workgroup member list and "drop" them. Time &



Chaos will prompt you to acknowledge your intent to exchange this information and ask if
you wish to attach a small note along with the item to be exchanged. Upon your release of
the information exchange, Time & Chaos will copy the information into the "store and
forward" database for future retrieval by the targeted workgroup user(s).

By default ... Appointments, ToDo's or Phone Book entries are copied from the workgroup
member's calendar set into the "store and forward" database ... none of the information is
removed from the sending workgroup member's calendar set.

The receiving workgroup member can choose to accept (or reject) the information transfer;
thus, instructing Time & Chaos to add (or not add) the information to their calendar set.

If a workgroup member wishes ... the information exchange can be started as a MOVE
instead of a COPY. This is done by holding down the [CTRL] key while performing the drag
and drop operation that specifies the information exchange. Note that is not only copies
the information the "store and forward" database but it also DELETES the information from
the sending workgroup member's calendar set ... if the receiving workgroup member rejects
the transfer then the information is LOST.

What if | just want to send a small note to other workgroup
members ?

In addition to exchanging Appointment, ToDo's or Phone Book entries, workgroup members
may send small messages (iNotes) to others within the workgroup. These small messages
(iNotes) are stored within the "store and forward" database for future retrieval by the
targeted workgroup user(s).






